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About Capture One 4 PRO features

This Users guide is created for all users of the variants of Capture
One, therefore you might find functionality that might not be present
in the application, though in the Guide.

All features presented with either the PRO-Feature logo or the
ORANGE header is regarded to the users that have Capture One 4
PRO installed.

PRO-Feature

ONE

1.0 Welcome to the Capture One 4 User Guide

Thank you for installing Capture One 4, Capture One 4PRO or Capture
One 4DB!

Phase One is proud to say that we have created this software to provide
a total solution for producing images of the highest quality from your
RAW files.

This next generation product is focused on exceptional image quality
and a workflow designed from professional photographer’s feedback.

This user’'s guide follows a problem-resolution-oriented approach,
not a bit-by-bit walk-through of the functionality. The guide describes
Capture One 4 for Apple® Macintosh®. The guide will to a large extent
apply to Capture One 4 for Microsoft® Windows® as well.

The interface may look different from Capture One 3, but the editing
functions are very similar, with significant improvements in some
areas.

The photographer’s workflow is paramount in this design.

Enjoy!!
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1.1 What is Capture One 4?

Capture One 4 is RAW workflow software; our improved image quality
gives you perfect results with minimum adjustments. We’ve tailored
each parameter of the image quality to ensure optimum results on
every camera supported, while keeping all the features you need
easily accessible.

The software provides a logical, step-by-step workflow through the
image optimization process, allowing you to work efficiently with large
volumes of images. Capture One 4 is capable of creating stunning
effects and quality from capture to finalized files.

ONE

1.2 Recommended hardware and software

Capture One 4 may run on older computers, but Phase One recommends
following the minimum requirement to ensure the best result from
Capture One 4. While you can run Capture One 4 on other computer
/ OS configuations than listed below - we do not recommend it. This
recommendation is made to ensure you have a good user experience.

Apple® Macintosh®:

Intelbased Macs

1 GB RAM (2 GB when working with digital backs)

10 GB free hard disk space

Calibrated color monitor with at least 1280x800, 24-bit screen resolution
Mac OS X 10.5.5



Microsoft® Windows®:

Intel® Pentium® 4 or equivalent

1 GB RAM (2 GB when working with digital backs)

10 GB free hard disk space

Calibrated color monitor with at least 1280x800, 24-bit screen
resolution

Windows XP®, Service Pack 3 or higher

Windows Vista® Service Pack 1

Microsoft® .NET Framework 3.0 Redistributable package

— In case you do not already have this installed, Capture One will
initiate installation of this.

We would recommend upgrading your computer in the areas below
if you work with high pixel-count cameras or simply want to optimize
performance:

Use processors with multiple cores, e.g. Intel Core™ DUO or better.

Having 2GB RAM or more.
Plenty of hard disk space for your images.

You need an internet connection when activating Capture One 4.

ONE

Capture One 4, Capture One 4 PRO or Capture One 4 DB?

The version of Capture One 4 is determined by the product key, when
you download the application it holds all 3 versions.

Capture One 4 was originally released in December 2007 now holds
significant updates compared to the version released.

Capture One 4 DB supports merely Phase One digital backs.

Capture One 4 PRO version holds a series of highly advanced tools
created to match the professional photographers daily workflow.

Capture One 4 and Capture One 4 PRO needs online access for
activation, but not for daily usage, whereas Capture One 4 DB does
not need internet connection for activation.

Feature/function PRO DB

Mac and PC support with transferable computer activation

Import utility with preview

Support for most popular DSLRs and Phase One
digital backs

< == b
<_

Tethered shooting directly into Capture One

Overlay feature for composition or layouts

Multiple monitor support

Customizable workspaces, tool tabs and floating tools

Instant, customizable Web contact sheet

Selective color adjustment for image colors and camera profiles

Styles tool for applying your custom looks to existing or new
captures. Provides an easy way to be creative with RAW files.

CMYK color proofing and output

High dynamic range tool to recover shadow or
highlight detail

Simple Moiré Suppression tool to help eliminate color moiré

Lens correction tools — Chromatic aberration, purple fringing, pincushion
and barrel distortion, vignetting control and sharpness falloff

< | 2L 2] 2 2] 2 | = =
<

< 2 2] = = 2 2w

Process multiple files with unique recipes from a single RAW file

* Tethered shooting only from Phase One backs.



1.3 Install and setup notes — how to

Before you install Capture One 4, please read the release notes
carefully!

Install on Mac OS X:
Capture One software includes an easy-to-use installer that will install
all the software necessary to run the application on Mac OS X.

To install the software please follow the procedure below:

1. Either load the Capture One DVD, or download the application from
the Phase One website: www.phaseone.com.

2. Open the Capture One disk image
3. Read and accept the license agreement presented
4. Drag the Capture One icon to the Applications folder

5. Open Capture One from your Applications folder

ONE

Install on Windows:

Capture One software includes an easy-to-use installer that will install
all the software you need to run the application on a Windows based
computer.

To install the software please follow the procedure below:

1. Either load the Capture One DVD, or download the application from
the Phase One website: www.phaseone.com.

2. Run the executable software install file.
3. Read and accept the license agreement presented
4. Follow the on-screen instructions to complete the installation.

- In case you do not already have Microsoft® .NET Framework 3.0
installed, Capture One will initiate installation of this.

10
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Manual update to latest version.

It is important to keep your application updated, normally you would
receive a newsletter reminding that a update is ready for download,
but it is "much more convenient to choose Capture One>Check for
Updates

If your Capture One 4 is donloaded from www.phaseone.com it will
always be up-to-date, but if you have installed a CD version it is most
likely that you can find an update ready for download.

- You can do scheduled checks for updates, read about this in the
section about preferences

Why can | not edit my files?

Capture One 4 is a RAW workflow application; this means that though
you can process TIFF, JPEG and DNG files, you can merely edit RAW
files.

Still you can see most files in Capture One, if a thumbnail is included
in the file, if the file is showing a small eye icon, this means that you
cannot edit the file, and then all tools will be “blinded”.

If the file is showing a pencil instead of an eye, it means that the file is a
read only file, or that the file is placed on a drive from where you cannot
work. This will often appear if you try working directly on a camera or a
burned CD, try instead and import the RAW files to a new session.

11



License

Activate Capture One
Please fill out the fields below.

License Code: M73U TTM9 XTRX 4c4U

Valid license code for Capture One. ®
Profile
E-mail: |
Get Profile
First Name:
Last Name:
Country: ! ®
( Back ) ( Help ) Activate.

License

Activate Capture One
Please fill out the fields below.

License Code: M73U TTM9 XTRX 4CaU

Valid license code for Capture One PRO. @
Profile
E-mail: newprofile@phaseone.com

Ne matching profile found, a new —
one will be created for you.

First Name: New

Last Name: Profile

Country: United Slalesl ﬂ ®
(sack ) (oo )

License

Activate Capture One
A new profile will be created for you. Please verify the
information and create a passwaord for your new profile.

New Profile

E-mail: newprofile@phaseone.com
First Name: Mew
Last Name: Profile
Country: United States

New Password

Password:

Confirm: Minimum 6 characters ®
( Back ) ( Help ) Activate
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1.4 Activation of Capture One 4
To activate Capture One 4 you need to be connected to the internet.

Open the license activation dialogue via the menu Capture
One>License.

Your first step towards activating Capture One is opening the license
activation dialogue in the application as illustrated.

Choose the mode you wish to run Capture One in - see tips box.

Enter your License code and personal details in the license activation
dialogue, type in the license code provided with your purchase of
Capture One. You received the License code either by email or with the
original software package.

Type in your details in the required fields to activate your software. Once
you have entered the information press the “Activate License” button
and your activation will be validated by Phase One’s activation server.
Your software is now activated and ready for use!

Troubleshooting

If you are experiencing problems activating the software, follow the
instructions provided in the application or visit our website for inspiration
and troubleshooting: http://www.phaseone.com/support

12
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License

Deactivate Capture One
Deactivation will remove the Capture One license from
this computer.

Once you deactivate Capture One, the application will
return to trial mode. If the trial period for this computer
has expired, all current and pending processes will be
cancelled, and you will not be able to continue working
with the application until you reactivate it.

EYes, I want to deactivate my license on this computer

([ Back ) ([ Help \.l

License

Capture One License
This version of Capture One has been activated.

License

License code: M73U-TTMS-XTRX:

Capture One

Registered to: newprofile@phaseone.com

Free upgrades left: 0
Activations left: 1

Activation History

Date

| Computer D

_A&iiralion T;ﬁe

( View the software license agreement )

Close ) Help )
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1.5 Deactivation of Capture One 4

To deactivate Capture One 4 from a computer you need to be connected
to the internet.

Open the license dialogue via the menu Capture One>License.

Press the Deactivate button.

Once you deactivate Capture One, the application will return to trial
mode. If the trial period for the computer has expired, all current and
pending processing will be cancelled, and you will not be able to

continue working with the application until you reactivate it.

Confirm that you want to perform the deactivation. After doing so, you
can activate Capture One on another computer.

13
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1.6 Calibrate your screen

Second to your camera and lenses, the monitor, with your computer, is
the most important piece of hardware in your workflow. In days of film,
it was possible to hold up a transparency or negative to the light or pop
it on the lightbox to know the density and color of the original image.

With a digital workflow, this is no longer possible and the monitor is
the only way to evaluate images. Consider your monitor the new digital
lightbox. To ensure accuracy, monitors need to be hardware calibrated
for accuracy. A quality monitor and calibration tool provides you with a
guarantee that what you are seeing on screen is correct

Once a monitor has been calibrated, the color and brightness controls
should be locked to prevent inadvertent changes.

How do we recommend calibration?

Hardware-based monitor calibrators are now available at reasonable
prices. The process is simple, quick and enables images to be judged
with certainty. If the budget allows, higher level monitors have internal
calibarating software that works with profesional calibration devices for
ultimate accuracy.

14
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1.7 Global application preferences

The preferences allow you to customize the workflow of the application
as desired. This can be useful when performing similar edits to a large
number of images.

What'’s the global applications preferences?
By choosing Capture One>Preferences you can choose to personalize
Capture One, by editing the global applications preferences.

General
Allow you to decide function of mouse scroll wheel and whether to
open a new session in a new window or not.

Capture in preferences

Choose standard extension from Phase One digital back, 11Q or Raw
TIF files. The TIF extension is default as it is compatible with older
applications.

It is important to emphasise that the TIF extension is a RAW file not the
TIF format known from e.g. Photoshop®

Shutter latency controls the timing between back and camera; some
cameras or backs can however not handle the fastest timing, these
should be set on long shutter latency.

Power module and Safe Mirror Up are both related to older Phase One
backs.

Appearence in preferences

The background of the Viewer can be adjusted to different shades of
gray, white and black. Best practice is to choose a dark background
color. This choice provides a calm, neutral background on which the
tools can be displayed.
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Crop in preferences

The crop preferences provide options for the Crop function. This
preference controls showing or hiding the grid, the opacity and the
mask, framing, and measurement.

This feature also allow you to control the Guidelines, and color of
these

Exposure in preferences

Exposure is about warnings; preset highlight warning is value 250 to
avoid your images will turn out with non-printable areas, you can enable
shadow warning too, in that case it could be a recommendable setting
to 3. — If enabled you can double click on the color area to change the
showed color and choose freely on a palette.

The Exposure Preference allows you to set warnings for exposure
values. The Preset highlight warning is 250. For best practice set the
shadow warning to 5. When enabled, the exposure warning colors can
be customized from the color palette.

Shadow/level

Shadow and level pickers allows you to set max and min values on
levels, to ensure that there will be no areas blown in case of e.g. off-set
printing of your image.

Software Update

You can set Capture to do automatic updates on schedule, Daily,
Weekly, Monthly or manual. If you set the update guide for manual,
read the “Manual update to latest version paragraph”
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Color in preferences

Color allows you to control the rendering intent; or how to convert one color
to another. The conversion is referred to as rendering intends, and below you
can see a description of the different ways of converting the colors.

Perceptual

Compresses the total gamut from one device’s color space into the gamut
of another device’s color space when one or more colors in the original
image is out of the gamut of the destination color space. This preserves
the visual relationship between colors by shrinking the entire color space
and shifting all colors - including those that were in gamut.

Saturation

Reproduces the original image color saturation (vividness) when
converting into the target device’s color space. In this approach, the
relative saturation of colors is maintained from gamut to gamut. This
render intent is primarily designed for business graphics, where the
exact relationship between colors (such as in a photographic image) is
not as important as are bright saturated colors.

Relative Colorimetric

When a color in the current color space is out of gamut in the target
color space, it is mapped to the closest possible color within the gamut
of the target color space, while colors that are in gamut are not affected.
Only the colors that fall outside of the destination gamut are changed.
This render intent can cause two colors, which appear different in the
source color space, to be the same in the target color space. This is
called “clipping.” Relative colorimetric is the default method of color
conversion built into Photoshop 4.0 and earlier.

Absolute Colorimetric

Colors match exactly with no adjustment made for white point or black point
that would alter the image’s brightness. Absolute colorimetric is valuable
for rendering “signature colors”, those colors that are highly identified with
a commercial product such as the yellow used by the Eastman Kodak
Company™, or the red used by the Coca-Cola Company™

17



Customize your toolbar
On Apple® OS you can change the entire User Interface.

At the top right corner of your Ul you find a tool icon giving you the
opportunity of customizing the entire toolbar.

When you open the customize window, you can choose to add or
remove parts of the user interface, you can also add more spacing
customizing the user interface any way you like.

To add a part you simply drag a part from the customize window and
drop it onto the toolbar.

To remove a part from the toolbar simply drag and drop the part from
the toolbar to anywhere on the screen, this way you can directly and
easily edit the toolbar.

Drag to get separated fields

Capture One! Jenny - 20060919_0

£. 0
Drag your favorite items into the toolbar...

9 R I : =

Rotate Undo/Redo Reset Adjustments Alignment Exposure Warning Copy/Apply Variants

+ ® o ma

Organize Import Process Comp. Mode Hot Folder Capture Preferences Customize  Separator Space Flexible Space

... or drag the default set into the toolbar.

' 9 : ey ®

Import Select . Rotate Crganize . Undo/Redo Reset Adjustments Cursor Tool Alignment Exposure Warning . Variants Copy/Apply Capture Comp. Mode

Show | Icon Only B: "l Use Small Size

ONE }
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Preferences

2.0 The new interface

The interface is divided into a number of elements, all providing a set
of tools. You should familiarize yourself with these elements and the
terminology to make this guide clear in its meaning.

The image to the left provides an overview of the interface elements.

2.1 Interface explanation — what is what?

Menu

Similar to other applications, Capture One 4 has a menu structure,
where key features are listed and can be operated from.

Toolbar

Below the Menu you find the Toolbar. The Toolbar contains buttons
for the most common features in Capture One. The Toolbar can be
customized to display only the controls you want. You can also choose
simply to hide the Toolbar, which provides more room for images.

Cursor tools
Even though they are a part of the general Toolbar, the Cursor tools in
Capture One are more than just that.

Cursor tool gives you access to key features right where you need them
without having to move your mouse to a toolbar and press a button.
With Cursor tools you don’t lose focus.

The Cursor tools gives access to a number of closely related sub-
features (e.g. zoom in and zoom out). The Cursor tools can be activated
by simple keyboard shortcuts. Read more on this in the Shotcuts
section.

Holding down the ‘Shift’ button when you use a given Cursor tools keyboard
shortcut allows you to cycle through the Cursor tool sub-features.

Trash

When deleting images, the RAW file will be placed in the OS trashcan
from where it can be restored in case you have second thoughts about
deleting the file.

If you installed Capture One 4 PRO the trash refers to the session
trashcan and will be stored here untill the session trashcan is emptied -
if you want the files directly in the OS trash, hold down alt+delete
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One or multiple image Viewer

ONE

Colorvalues

‘\ Lightness

Viewer toolbar

The Viewer toolbar is closely connected with the Viewer. Here you can
toggle between 1-up and multiple-up viewing. You can also control the
zoom level of the images. In the center of the Viewer toolbar the RGB
and Lightness readout values are available.

Viewer
By size the biggest element in Capture One. The Viewer is used for
viewing the images and checking the effect of the adjustments made.

You can see up to 12 images simultaneously in the Viewer. With tools
such as Compare Iltem and shortcuts for synchronized zooming and
panning, image comparisons can easily be done.

If you want more space for the Viewer you can hide the Tools and the
Browser, which provides close to full screen viewing of the images. The
ability to hide the Tools, Browser and the Viewer also can provide more
room for other interface elements.

The top-left Icon of the Viewer allows you to choose between one or
multiple image viewer.

What are the images exposure parameters?

The parameters are right on top of the image, this indicates the values
of RGB and the last digit is a Lightness or Luminance value, a value
created to illustrate the dark/white ratio of the different colors, like in
RGB the darkest will be 0, the clean white will be 255. This scale could
also be compared to the HS scale.
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Size of Thumbnails

Size of Thumbnails

Browser

Thumbnails of all recognized images in a given folder or Album are
shown in the Browser. The browser will show Thumbnails as they are
corrected, and show the entire view and mask if the image is cropped.
Use the Browser to navigate images in a collection and to select images.
Many actions can be performed in the browser, such as rating images
and use selected cursor tools on them directly.

By hiding the Browser there is more space for the Viewer. Place
the Browser next to or below the Viewer, if desired. Play with the
configurations to find out which suits you best.

Browser toolbar

The Browser toolbar controls how you display the thumbnails in the
Browser. Here you can choose to show the thumbnails in grid or list
mode. Grid mode shows thumbnails, whereas list mode shows the
images in a tabular format along with key exposure information.

You can also control the zoom level of your thumbnails in the Browser
toolbar.
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Tool Palette

Tool Palette is the common name for a group of tools forming an interface
element. The tools found here give access to controls for adjusting your
images. Here you can also browse through albums and process your
adjusted raw files. In other words this is your image control center.

The Tool Palette consists of a number of Tool tabs, which, when read
from left to right, outlines the most favored workflow sequence. The
Palette can be placed to the left or right of the interface or hidden per
your preference.

Tool Tab
There are many Tool Tabs, each giving access to features that will let
you find, adjust and process images.

Each Tool Tab contains a number of tools. Most of the tools contain
controls which are related to and influence the function of the tool.

What color space are the histograms shown in?

Placed at the top of several of the Tool Tabs you will find a guidance
histogram. This histogram gives you an up to date visualization of the
exposure in your image.

The Histogram reflects the output RGB color space.

If you have changed the image into BW, then the histogram displays
monochrome. It is worth noticing that even though the Histogram
displays monochrome, the processed image will still be RGB.

All tools in the Tool Tabs of Capture One have up to 3 automation
shortcuts:

Auto

The Auto feature optimizes the image from the controls in the specific tool.
Reset cancels all changes you have made to controls in a given tool. The
Presets feature lets you define and save tool settings for later use.

22



L g |

& D
L
|
L]
||
L]
=

ONE

RISTICS

Phase One P 65+ Flash

Process

Library

The Library tool allows access to the images within the Albums you
have created as well as to any image collections you have stored in
folders on a computer or networked resource. The Library is very similar
to the file browser in the operating system (Finder on Mac, Explorer
on Windows®) and is closely connected with the file browsers in the
operating system. You can easily browse through the image collections
due to the hierarchical tree structure of the library.

The Library tool allows you to designate an output folder, a move to
folder, a Capture folder and a trash folder. More information on these
folders will be discussed later on in this guide.

Quick

The Quick tool tab includes a selection of key tools which gives easy
access to tools for fast image enhancement. In Base characteristics
you can choose between different ICC camera profiles and film curves.
An ICC profile is automatically applied according to the make and
model of the selected RAW file, but check the ICC profiles, we have
created several specialized ICC profiles to many cameramodels, to fit
all needs.

Use curve to set the basic behavior of the pixels, stadard/high/low
contrast film or linear(especially for scientific photography).

After ICC profile adjust white balance and exposure, and process the
selected images from here.
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Capture

The Capture tool tab is your gateway to tethered shooting with Phase
One digital back. You can control the ISO and white balance as well
as copy your settings from one capture to the next captures. Here
you can also decide the naming and location of the captures you are
creating, the tool tab will automatically activate all controls once you
have connected your Phase One digital back to the computer. If you
have installed Capture One 4 PRO you can also shoot tethered with
Canon DSLR cameras.

The Exposure Evaluation will show the values of the capture not only as
a historgram, but also on the slider showing the under/over exposure in
aperture values

Phase One digital back owners can apply ICC profiles in this tool tab to
optimize color reproduction.

Color

The Color tool control allows you to remove unrealistic color cast in
your image caused by undesirable lighting conditions; this makes
objects which appear white in real-life rendered white in your photo.
In this tool tab you can also adjust hue and saturation for your colors,
thereby changing the overall color balance.

The Color editor will let you work on specific colors, when a desired color

scheme is achieved you can decide to save this color scheme for later
work, or even use the ICC profile or style directly in a tethered session.

24



ONE

150 100
CROP

Unconstrained

OVERLAY

¥ Show

File /Volumes/LaCiefAnas... Custom Name 032.jpg

AF 35mm /3.5
35mm
None

Default

& Chromatic Aberration (Default)
W Purple Fringing

W Distortion

¥ Sharpness Falloff

W Light Falloff

Vignetting

Exposure

The Exposure tool tab provides controls to adjust the exposure of
images. There are basic controls (e.g. Exposure Compensation) which
affect the whole image, and there are also advanced controls (e.g.
Curves) which allow for fine-tune adjustments.

Composition

The Composition tool tab provides the crop feature which allows you
to emphasize image elements. Here aspect ratios can be applied to
images to meet output format needs. Rotate and Straighten tools are
also available from this tool tab.

Lens correction

The Lens Correction tool tab provide various different lens correction
options, either automatically using Phase One knowledge on the
individual lens or manually correction of e.g. distortion

Also you will find features to reduce Chromatic Aberration and Purple

Fringing. These filters are based not only on image analysis but also
knowledge about the lenses.
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Details
Image sharpness and noise reduction is controlled from the Details
tool tab as well as the PRO features Moiré and Clarity.

To make your expedite the editing process the Details tool tab includes
a navigation tool which quickly allows you to check the details anywhere
in the image at any zoom level.

Adjustments

The Adjustments tool tab provides a clipboard with image adjustments
which can be copied from one image and applied to other images. The
default copy contains only the parameters where actual adjustments
are made to the settings of the source image.

DO AT OOE &

METADATA

Name Value
Basic
File name 20060919_057.TIF
Rating
Caption Jenny

Copyright Copyright © 2006 Ni... Metadata

* EXIF - Camera

s E*-Lacse One Any copyright and caption information you have added to an image are

Serial CNO10591 shown in the Metadata tool tab. Basic file information and basic EXIF
—e e information for the image, such as camera make, model and exposure

Software Camera back, Main fi...
Owner data are also shown here.
Lens 120 mm at f/8
w EXIF - Exposure
Shutter speed -5
Aperture fie
150 speed rating 100
Exposure com... --
Flash mode -
Flash compen... --
Exposure prog... Undefined
Exposure mode ==
Metering mode --
Drive mode/s... --
Focal length 120 mm
White balance auto

Color space -

Dimensions 6496 x 4872

Format -

Date 19/09/2006 15:21:48
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tiff 8bit 300 Dpl

nat

ICC Profile
Resolution

Scale
Sharpening

fith

Format

TIFF L Bbit
MNone
Adobe RGB (1998)

300  puxfin
Fixed

100 %

Disable

None

¥ Create thumbnails on save

Job Name and Counter

Fashion|
Fashion006
JUsers/hla/P...rary/Output

MMARY

Filename

Format
File Size

bit 300 Dpl (and 3 more)

006.tf

Process Recipe
This tab allows the process parameters to be defined and for the images
to be processed.

You can define a Process Recipe, Parameters such as file formats,
quality, color space, resolution, and size can be configured.

It is also possible to systematically rename the output files, as desired.

If your version is Capture One 4 PRO you will have the possibility of
saving your process recipe as well as processing for mutiple formats at
the same time.

Batch

You can see which images are in queue for processing and which
images have been processed previously within the Batch tool tab. You
can change the order of processing by drag-and-drop. Delete images
from the batch queue by marking and pressing backspace. Batch will
start automatically when you have pressed process.
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[T N\ File Edit View
About Capture One

Preferences... 8,

License...

Edit Keyboard Shortcuts... |.

Services B
Hide Capture One ¥H

Hide Others X 3#H

Quit Capture One #Q

Enter a name for the keyboard shortcut set:

my personal shortcut set

( Cancel ) ( oK k)

How do | create my personal shortcuts?

If you have preferred shortcuts you may want to add them or change
the default shortcuts.

Select Capture One>Edit keyboard shortcuts (on PC Edit>Keyboard
shortcuts will take you to preferences).

This window allows you to duplicate the entire set of shortcuts, rename
the new set, and now you can start editing or adding short cuts.

We want to add a shortcut to create Web contact sheet, simply double-
click on the shortcut, empty or not, and create your own new shortcut.

Now your new shortcut is automatically saved, and you can find your
shortcuts in the list in the future.

- If you for some reason prefer the shortcuts from Capture One 3.7 -
just select the shortcut set from the list.
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How can | edit more captures at once

Capture One now allows you to edit all selected without usage of
Shift.

The “Edit Primary Variant Only Function”, now makes it possible for you
to select more than one image and only work on the selected variant —
the one with the white frame.

If the button is NOT activated you will automatically adjust all selected,
when using the “A” function, Import, Rotate, Move-to, reset Adjustments,
Trash, Rating, Process.

If you want to add a load of changes, then finish the changes one

capture, copy the changes, and add them to many captures, this way
you will save lots of working hours.
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cify Tab Name How can | create my own personal workflow?

For Apple® users that finds the recommended workflow awkward
compared to your preferred tools, you can create your own tool tab.
iy i View>Create New Tab will open a dialogue box for you to name your
new Tab, the lIcon for the tab will be “1” for the first custom tab “2” for
the second and so forth.

Feature

B2 Adjustments Camera I

Sort >

Hide Viewer In principle you can continue filling more tools on the tab until all is
Viewer Mode > there, when the area is packed the tools will automatically collapse
Viewer Zoom > to make more space, of course to save time in your workflow it is

Hide Viewer Labels

Show Exposure Warnings 3E
Show Grid and Guides #®C
View Selected Color Range

recommendable to not provide more tools than you can have the entire
workflow open at one time.

Your new tab is empty when created, right-click on the empty area and

Adjustments Clipboard

:'de B“’str e Yi: o i select the tools you prefer from the entire tool palette, you can of course
p{:::sgerrm:s:r Ric;hi 0B Eul"'f,h“ decide the placement of the single tool on the tab after selecting.
Browser Zoom > Sl
Browser Labels I s

Hide Tools 8T Hioh Dynumc Range
Tools Auto Mode 8T sl
Place Tools Right CRT el

Library Tab &l :‘:{;mr

Capture Tab 12 i
Quick Tab &3 Noise Reduction
Color Tab 384 ol e
Exposure Tab 5 st

Lens Tab &6 B e
Composition Tab N7 Sharpening

Details Tab oy
Metadata Tab bl
Adjustments Tab

Qutput Tab

Batch Tab

Previous Tab N+~

Next Tab X

Hide Toolbar

Customize Toolbar...

Proof Profile I

ONE %




| Window 1.2
Zoom Window ~nz
Minimize BV
Bring Al to Front

Events.
Workspaces >

+ Capture One 4 PRO session: P65+ Drew - CustomName0000121

LULGEE Help Window WG]

Zoom Window Zoom Window
Minimize : 1 ¢ Minimize

Bring All to Front Bring All to Front

Viewer Viewer

Events Events

[ v Default

X Two-Monitor
v Untitled: 20060919 Jenny v Untitled: 20060919 Jenny

Default
Two-Monitor

v My Workspace .

Save As...
Delete

How can | arrange my desktop tools?
All tools can be removed from the tab or moved to float free
(MAC only) or in groups if preferred.

You can even choose to move the individual tools to your
second monitor, or if you prefer you can move the viewer
image by itself — select Window>Viewer to release an extra viewer to
be placed on the second monitor.

MAC ONLY: When you have created or edited your new personal
workflow you can choose to save the workflow as your personal
workflow, this feature allows storage of several workspaces, providing
all users of Capture One their preferred workflow and setup.

Saving workspaces also covers two monitor setup.
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3.0 Capture One, beneath the surface

What is RAW?
RAW is a term used to describe the unprocessed data generated by
sensors from digital cameras and backs.

The data is generated when light is received by the photodiodes on
the sensor. Depending on the intensity of the light a stronger or weaker
signal is generated. This data is read off and stored as unprocessed
data on the memory card. When shooting RAW+JPEG on a DSLR
camera two images are stored. Basically the RAW data is stored and
processed while simultaneously processing a JPEG by the camera’s
built-in computer.

A RAW file contains more than one set of data. A DSLR file contains
calibrated RAW data plus the file header. A digital back file contains the
actual raw data, calibration data for the digital back files and the file
header information.

With digital back raw files the file header is kept separate from the
image data. The file header contains what is described as metadata;
data about data. Metadata is information recorded by the camera at the
time of capture and consists of the following:

¢ Image Thumbnail (usually a TIF, but sometimes a JPEG)
e Time/Date

¢ ISO

e Exposure information

¢ White balance (that the image was shot at)

e Contrast curve

* Recorded pixel size

e Camera data (shutter speed/aperture/focal length etc)
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Capture One 4 image engine processing
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ONE

More than 100 pieces of data are stored. We work with the details of the
exposure, ISO and white balance.

The white balance determines how the file will look when Capture One
creates the preview. The ISO, exposure data and camera model information
are used to calculate the noise reduction used by Capture One.

How Capture One 4 reads an image

The process of reading and converting RAW data into an image is a
complex one. Digital sensors contain pixel sites that are sensitive to
three colors; red green and blue. Each pixel site can read only one
color. Groups of four pixels make up each tile of the sensor mosaic; two
green pixels, one red and one blue.

Capture One needs to “de-mosaic” the information to produce image
files with three colors per pixel. This process uses an extremely
sophisticated and patented algorithm, which is one of the fundamental
reasons the quality of files produced by Capture One is superior.

The in-camera settings ISO and white balance are applied to the image
together with the formula developed for Capture One 4 when the
preview is created and displayed in the Viewer.

Once a RAW file has been read, nearly all the variables can be changed
such as contrast curves, sharpening and white balance e.g. all are
applied to the image when the preview is created by Capture One and
displayed in the Viewer.

The changes you make to the image in Capture One are applied to the
preview and added to a settings file. No changes are made to the RAW
data at any time.

Once the process button is pressed, RAW data is processed using the

settings file. At this point the true pixel-based image is formed and
output to specific dimensions.
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Capture One 4 recommended user workflow
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An important feature of Capture One 4 is the ability to create Variants.
Each of these variants is a duplication of the settings file, not the
RAW image data. Multiple variants can be created which provides a
multiplicity of edits. Since they are only a few kilobytes each they take
up very little space on the harddrive.

Capture One 4 workflow

Changes to images can be made in any order and little difference
will result in the final file. However a structured approach to using the
software leads to an efficient workflow and Phase One suggests that
the following as the most efficient way of processing files:
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3.1 Color in Capture One 4
Color is dealt with in two ways in Capture One; internally and for output.

Internally, Capture One works in a very large color space, similar to
that captured by camera sensors. A large color space ensures that
little clipping of the color data can occur. Clipping is the loss of image
information in a region of an image. Clipping appears when one or
more color values are larger than the histogram (color space of the
output file).

At the end of the workflow, the RAW data has to be processed to pixel
based image files, in defined color spaces. These spaces are smaller
than the internal color space used by Capture One. When processing
some color data will be discarded. This is why it is paramount to perform
color corrections and optimizations to images before processing to a
smaller color space.

How the color is handled
By reading the camera-generated RAW information, file header and
settings file Capture One provides accurate color.

Each new camera model is subjected to many tests by Phase One R&D
in order to generate a perfect color profile.

Once the camera model has been established by Capture One the RAW
file is then assigned a color profile. The RAW data is then translated to
the internal working color space of Capture One. It is here that the edits
are made.

During processing stage, the image data is converted, by means of ICC
profiles, to industry standard spaces, such as Adobe RGB or sRGB.
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Color output settings

Capture One 4 can output to any RGB color space and CMYK if Capture
One 4 PRO. All that is necessary is the ICC profile is available on the
local machine.

For Web

Images that will be published on web sites should be processed into
the sRGB color space. This is because few web-browsers are capable
of color management and the subtleties of images will not only be lost,
but incorrectly displayed.

For Print

Images for print should be output to suit the requirements of the client
or lab. Adobe RGB color space is a large colorspace, capable of
expressing a wider gamut of colors than sRGB, making it the preferred
choice for images that will be extensively processed or retouched.

Be sure to ask the client or lab which color space they prefer. This will
depend on the type of reproduction or printing machine in use.

Camera Profiling

Embedding the ICC color profile into the processed file (ICC Profile>
Embed Camera profile) ensures that no color changes are made to the
image data, particularly important for creating camera profiles.

Retouching/Manipulation

When processing for retouching and manipulation it can be useful to
output in 16 bit to ProPhoto RGB, an even larger color space than
Adobe RGB. Be sure to ask the retoucher what is preferred.

CMYK Color spaces

Capture One 4 PRO provides a selection of the most common CMYK
color spaces, many photographers prefers to do CMYK converting them;
it secures the quality of the photo when this converting is performed by
the artist and not in post production. CMYK is controlled on the output
tab.
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4.0 Organizing the workflow

The Library tool tab in Capture One is where all file import and file and
folder organization takes place.

In the folders section of the Library Tool Tab, navigate through the folders
to one that contains RAW files. When the folder is highlighted, previews
of the RAW files will be created and displayed in the browser.

The Library Tool Tab provides an overview of all folders on the local
machine and even on the network if sharing has been enabled.

4.1 Finding and importing files

How can | import images?

Browsing to a disk containing RAW images on a local or network
computer or by importing directly from a memory card in a card
reader.

Choose File > Import images or select the import images button to begin
the import process. Immediately, a large dialogue box appears showing
a preview of files to be imported. This dialogue box also provides a
range of options from which to choose.

Inserting a memory card into a card reader will also bring up the import
dialogue window. The Import window offers a range of options to make
importing a quick and straightforward task.

It is important to remember that you are importing images from one
location to another. You need to create or define a folder to which the
files will be imported to. This can be done manually or through the
Locations tab on the file importer window.

Capture One 4 can automatically create subfolders, named by date or
userdefined. When importing you can also choose to rename the files,
as they are imported from the camera or cd/memorycard, the file names
can be changed by doubleclicking on the filename in the browser or
when exporting the files.
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How can | export my files?

Files can be exported in several ways from Capture One 4. The original
RAW files are never changed by the application, so they can be exported
to another application or folder at any point.

It is important to emphasize that when you export files — you process the
raw file meaning you create a new file based on the raw file containing
the editing you have added. After process and export to another folder
you will find the original raw file in the original folder.

Processed files can be exported in arange of formats that can be opened
by industry standard imaging applications, read more on fileformats in
the output chapter.

All files can be exported to any folder on the local machine or connected
network, you can add Copyright and Captions allready at Import.
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How can | organize my images?
Capture One allows you to organize images in a variety of ways to suit
your preference.

We recommend importing images to a folder on a main drive using the
importer dialogue (File > Import Images). At the same time, the images
can be copied to an archive or backup disk for greater data security.

The images should be edited. Move the best examples or those with
the highest rating to a separate folder using the [Move To] function.

Once rated and moved, the best images can be quickly optimized
before proofing to clients as JPEGs or creating web gallery. The web
gallery function built-into Capture One 4 is extremely quick (File>Make
Web Contact Sheet). The web contact sheet will, in addition to the
images, show caption and copyright information, which can be added
when importing files.

Once the client has approved or selected the best images, they can be
further refined using the built in tools.
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What are Move-To Folders?
Move-To folders help create an effective and extremely rapid workflow
by moving great images to a seperate folder, rather than rating, selecting
and then moving the images.

How do | use the Move-To functionality?
Select the folder with RAW files, Right Click > Add New Folder.

Name it appropriately (Select, Best, Keepers) and then select it, Right
Click > Set as Move To Folder.

When moving through images in the main image folder, any file can
be selected and moved to the new folder by clicking on the Move-To
button or using Cmd/Ctrl J

To see the images that have been transferred to the Move-To folder, go
Library > Application Folders > Move-To Folder

An alternative way of working is to create a single folder that will always
serve as the Move To for all images. Follow the same procedure or
simply navigate to a chosen folder, highlight and Right Click > Set as
Move-To.

Output Folder

In the same way that Move-To folders can be specific to a group of
images or a nominated folder on the hard disk, the output or process
folder can be set in the same way, depending on the preferred way
of working.

To add it as a sub folder for a group of images, follow the procedure
for Move-To above and when Right Clicking, choose ‘Set as
Output Folder’.

To create a single output folder on the hard disk, double click on

Application Folders > Output Folder. A dialogue will appear, navigate to
the folder you wish to use for your outputs or processed files.
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4.2 Rating files

Rating the images offers a way to sort through the images in a meaningful
way. Rating is available from 1 to 5.

How can | rate images?

Rating (marking images with stars based on preference) can be done
in the Browser, either in list or thumbnail view. Simply select the image
that will be given the same rating and use the number keys 1-5 on the
keyboard to apply the rating.

Grid mode makes it easy to rate. Navigate using the arrow keys and
press 1-5 as desired. This is an efficient way to rate images quickly.

Alternatively, select the image and then Adjustments > Rating from
the menu.

To remove a rating, hit 0 choose Adjustments>Rating>Unrate.

Can | give the same rating to multiple images at once

If you select more images you can rate them either by pressing [CTRL/
mac] or [Shift/Win] and pressing 1-5 or Adjustments > Rating from the
menu.

Can | sort my images by Rating?

Images can be sorted by rating. Go to the Browser Toolbar and select
list view and then press sort. The images will be sorted in ascending
order from 1-5. To reverse this sort order press sort again.

Can | select by rating?
Images can be selected by rating. Edit > Select by rating.
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Colortag

The PRO version provides color tagging as a rating and/or sorting possibil-
ity. Sort your capture in up to 7 different colors, this feature have been
wanted from many professional photographers.

Color tagging is easier overviewed visually than rating.

Use colortag side-by-side as a sorting possibility with the rating system,
this provides a possibility of a divided priority between you and your client,
or assistant(s).

Right-click on the square next to the thumbnail and the color tag menu ap-
pears, or select Adjustments>Color Tag and choose the color.

After tagging the images, you can sort by colors.
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LIBRARY

Session: Capture One

Close tool

New Album
Rename

Remove from Favorites

Set as Capture Folder
Set as Move-To Folder

Show in Library
Show in Finder
Hide Info

Import...

Set as Output Folder
Set as Session Trash Folc

4.3 Working with albums

Working with albums

Album folders are virtual collections. Albums is an easy way to compare
images from different folders, without having to place the images in the
same folder. In addition to this, Albums only references images from
folders, it doesn’t copy them. Making changes to images in Aloums will
however affect the source image.

How can | create a new album?
A new album can be created in several ways.

File > New Album or
Library Tool panel: Right click > Add New Album

How can | add images to an album?

Images can simply be dragged individually or as a group, to an album.
When the images are moved a variant is created, so the original remains
in its location.

How can | remove images from an album?

Select the image to be removed and hit the backspace/delete key or
right click on the image and select delete. Only the variant in the Album
is deleted, the original RAW file in its folder remains.

How can | move images between Capture One and my OS file
browser?

Images can be dragged and dropped from the Capture One 4 Browser
into the OS file browser and vice versa. Using the Option key during
the drag/drop operation allows you to switch between move and copy
operations.

If the image movement is initiated from Capture One then the associated
settings file will also be moved along with the image. Your image settings
changes will not be lost.

If the image movement is initiated from the Finder then the associated
settings file is not moved; unless you manually move the settings
separately any changes will be lost when reading the image from the
new location.

How can | remove an album?
Highlight the album and go Edit > Delete Album. Alternatively, right
click > Delete.
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How can | easily compare images?

The Compare Item feature is a tool that helps to compare one image
with multiple others. This helps to progressively determine the best
image from a similar group.

Hit the Enter button and the selected image is automatically set as a
Compare Item and the Viewer switches to multiple up mode, comparing
your image of choice to the next image in the sequence. This can also
be a powerful tool when doing tethered sessions, compare the “best”
MO QORAINO®DE & ¢ : shot with the incomi.ng captures as they land on your computer.
LBRARY . s Your Compare Item image has a thin orange frame around it.

To set a new Compare ltem you simply hit Enter on the image you have
selected (either in the Viewer or the Browser).

R R rooE® To deselect a Compare Item altogether you hold down Cmd and hit

s O Enter when having selected the Compare Item.

4.4 About Favorites

What is a favorite?
A favorite is a bookmark or a shortcut for a regularly used folder.

Favorite folders are cached, which means that it is faster to access
images stored in these favorites over and over again.

Pt How can | make a folder a favorite?
New Album : Select a folder, so that it is highlighted and go File > Add folder to
New Folder favorites. Alternatively, Right click on a folder in the file browser and
chose “Add to Favorites”.

Rename
Add to Favorites

Move to Trash

How can | remove a favorite?

Set as Capture Folder

Set as Move-To Folder Select the favorite and hit backspace/delete or Right click > Remove
et as Uutpu olaer ut .
Set as Session Trash Folder from Favorites

Show in Finder
Hide Info

Import...
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When working in projects as many photographers are doing, it is natural to
store the project as a complete project instead of spreading the files, es-
pecially when your work often will consist of raw files, settings files, library
files and output files. When saving a session you will also automatically
create a session file, this file will re-open the session providing you an easy
access to an already done project.

Many photographers prefer to split up a client’s session in several sessions,

to keep products apart, or images in a page-by-page system according to
the page in a catalogue.

Creating a new session is an easy task, which will save you loads of working hours.
Choose File>New Session
The New session box opens

Use a relevant name for the session, this will make it easier finding the ses-
sion if needed later on.

Decide where to place the session folder; this folder contains the relevant
sub-folders, which you can rename too.

TETHERED/untethered: if you select tethered you have the possibility of
shooting tethered directly in the session, you can change name of the Cap-
ture subfolder, and this folder will also be placed in the session main folder.

The Move-to folder provides a session based lightbox, in fact likewise the
favorite folder, but use cmd+J] to sort you the photos in your session in an
easy way.

The out-put folder contains your processed files.

The Trash folder this does not refer to the OS trashcan, but is a session
trash — only when the session trash can is emptied will the files go to the
OS trash.

Let the session open in a new window and Capture One is ready for work.
You will see the name of the session on top of the library tab.
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Check the folders link by marking the individual folder in Library
Tool Tab, if the link is set to be absolute, the link will not be auto-
matically adapted when moving the session; to make the sub-
folder follow the sessionfile set this the link to “relative”.

Feature

When the session is done, close the window, and you will later be
able to open the session, and all files will be as you left them.

When you want to re-open a session you can either choose File>open ses-
sion and browse you way to the session file SESSIONNAME.COL or browse to
the file, double-click in your OS browser and Capture One will automatically
open in the session.

Can | work with more than one session at the time?
Open your sessions in new windows, this way you can have more than one
running process, this enables you to keep shots or clients for themselves ...

How do | move a session to another computer?

600 A sessions is movable, browse to the session’s folder, and move all files in
(=[] = BT~ the folder.

¥ DEVICES il Capture One Library L & Capure -

2 mac o _m'm:mcobun n m-:r-::n rest.cols "

as 5 Outaun . This is created not only to make archiving easier, but also to make it pos-

¥ SHARED B Trash -

sible to work on both platforms for the same client.

Please notice, when you move files, the session subfolders should be linked
P65+ Drew Output Folder relative, to assure automatic update of the link. If the link is absolute, you

691.6 MB 0 KB will loose connection to the folders when changing location.
{Usersfhla/De...es/P65+ Drew JUsers/hla/Pic...ibrary/Output

Absolute = Relative to session

Thursday, Sep... 2008 6:42 PM Friday, Octobe...008 10:00 AM
Monday, Octo...2008 11:32 AM i: Friday, October 3, 2008 3:05 PM
readable & writable readable & writable

ONE .



How can | find/recover files from the session trashcan?
Files deleted by clicking the trash can icon will be placed in the session’s
Feature 5 ; trashcan, also seen as the trash folder in the Library tool tab.

From this trash folder you can retrieve images very simply by going to the
library tool tab select Trash Folder, now you can see the files in the Trash
Folder and you can easily retrieve these by drag’n’drop back into the folder

you want them - Capture One will automatically move the cache and set-
tings files.

Files Move
o e e e The session’s trashcan is emptied by selecting File>Empty Session Trash.

Edit View Adjustments

New Session... 38N
Open Session... ¥0
Open Recent Session [
Close Window BW

Import Images...

New Album

Files Move

Files will be moved to a new location.

== == " Empty Session Trash

IR I

Export Profiles...

ONE
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Can | change name of the capture after import?

Sty In ElndeE If you wish to change the caption after import, this can be done

Batch rename Nl easily. Select the images you want to change caption on, and
Rating

Color Tag

Set as Compare Variant

right-click on one of the selected images in the browser.

New Variant R Now you have the image browser menu, providing tagging, variant and

e v rotation features amongst other options — but second from the top you
B Caustrgent : will find Batch Rename; this feature allows you to rename many files at
Copy Adjustments

Apply Adjustments once.

Rotate Left o . . .
Rotate Right A small Batch Rename window will open, you can choose between job
Move to Folder ) name and counter, job and image(capture) name, image(capture) and

job name, when the dialogue if filled out press Rename, and the files
will instantly be renamed.

Trash

t Job Name and Counter

Photokina P65 demo -

e Photokina P65 demo - 001

Cancel Rename
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EXPOSURE EVALUATION

MEXT CAPTURE MAMING
Mame P65 session
Sample P65 session-6141.TIF
Location fUsers/hla/Pictures/... One Library/Capture
Space Left 117 captures (8.03 GB)

CAMERA

Camera Phase One PE5S+
IS0 50
Balance

Format [IQ Raw L

MEXT CAPTURE ADJUSTMENTS
ICC Profile  Phase One P 65+ Outdoor Daylight

Other Defaults with Style (Color - 70's look)

ONE

With Capture One you can speed up the creative process by capturing
images directly to the computer and have them appear almost instantly
in the application.

Capture One lets you shoot tethered with your Phase One digital back,
Canon DSLR or Nikon DSLR which means you are shooting images
directly onto your computer without any interim storage.

To shoot tethered connect your Phase One digital back or Canon DSLR
to the computer using a FireWire cable, the digital back will automatically
be recognized. USB can be used if necessary.

The Capture Tab is the control center for shooting tethered.

When you are shooting tethered with a Phase One digital back, you can
select the folder where you want to store the captured images. You can
do this directly from the Capture Tab or alternatively in the Library tab.

Capture naming will allow you to control the name and numbering of
your captures, write the desired capture name, if you need custom
numbering, choose between 2-6 digits as well as the camera counter.

Check if the ISO, white balance and file format is as you want, if they
aren’t you can change them directly in the Capture menu.

With the Next Capture Adjustments tools you have flexibility in setting
capture presets (e.g. ICC profile, white balance, exposure adjustments
etc.) for the images to come, thus creating a series of images with
consistent looks already from the capture moment.

From the next adjustments tool “Other” you can recreate the look of
either your primary selected image or the last capture. Any changes
you have made to these captures will be applied to the next capture. Or
you can simply stick by using the default settings.
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Uncompressed

N3 Raw 5

JUsers/hla/Pictures...One Library/Capture .
104 captures (7.24 GB)

ra Phase One P65+
50

ormat I} Raw L

ONE

5.3 What are 11Q RAW S and 11Q RAW L?

Phase One digital back users can choose between storing their tethered
captures in 2 different types of compressed RAW files. The format for
the captures can be set by using the camera tool in the capture tab.

Intelligent Image Quality RAW, [1Q RAW, is an intelligent way of turning
the full 16 bit image data captured by the camera into a compact RAW
file format.

What makes the 1IQ large RAW format unique is that it is completely
lossless. [IQ RAW Large, can be processed in to a 16 bit TIFF even
though it is only half the size of a traditional RAW file.

[1Q RAW Small format is based on the full 16 bit data captured by the
CCD, but unlike IIQ RAW Large it is not 100% lossless. However if your
capture is made on low ISO and well exposed, there will be no difference.

What is uncompressed Raw?
Uncompressed Raw is a Phase One legacy format supporting older
digital backs.

How do | start a tethered session?
Tethered photography is very straight forward on Capture One 4 PRO.
Plug your Phase One digital back or supported Canon or Nikon camera
to your computer, for perfect workflow check the hardware set-up
compared to the recommendations.

Turn on Capture One 4 PRO and create a new session, select tethered
session.

Your camera will automatically be recognized by Capture One if
supported and connected properly. It is recommended to use FireWire
cable of max 4.5 meters, as longer cables from time to time can provide
a less stable signal.

You are now ready to shoot, the capture will automatically pop-up in
your viewer as you do the shots.
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Image Window Help

Composition Mode
v Hot Folder Enabled
v Auto Select New Capture

Orange=Compare variant

ONE

5.4 Using Hot Folder

If you have installed remote capture and control software for your 3rd
party camera (see tips box) you can use the Hotfolder functionality to
have captures appear almost instantly in Capture One. To activate this
feature enable it from the Camera menu. Capture One 4 willautomatically
show the latest image added to the folders

5.5 Can | compare images while shooting?

Combine tethered shooting or shooting using a Hotfolder with the
Compare ltem feature in Capture One and you can have two or more
images appear side-by-side for comparison. On the one hand side you
have your favorite (i.e. The Compare Iltem) and on the other hand side
you have your incoming captures. This provides easy comparisation
between your selected preferred shot and your latest capture.

Can | change ICC profile during a tethered session?

You can change ICC profile at any given time. It is important to notice
that some supported camera models does have more than one ICC
profile designed to optimize the many different capture situations a
professional photographer can experience.

If you select an ICC profile for another camera you might very well

experience the captures turning out very wrong — as the various different
cameras interpreters colors very differently.
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EXPOSURE EVALUATION
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5.6 How can | do test shots?

A smart way of doing test shots, is by choosing
Camera>Composition Mode; add a “V”checkmark here or by
pressing the toggle composition button. When in composition
mode the latest capture will allways be saved op the previous
capture erasing the previous, if you do a capture that is
satisfying during your test shots, simply unclick the checkmark or the
composition mode button, this way you can allways decide to keep a
great shot — this is a very simple and easy way of making test shots,
without using valuable hard disk space.

What does exposure evaluation show?

Exposure evaluation is in fact the Histogram of the latest captured raw file.
When editing the raw file after capture, you will se the changes made in
the histograms in the different relevant tabs. But the Exposure Evaluation
will stay as originally captured, as it is referring the exact capture.

Right below the Exposure evaluation you will find the Exposuremeter,
this provides an indication on under/overexposure based on center
weighted measuring and calculated in aperture values.

The marker is made to be viewed at a distance to make estimating
the exposure easier when working tethered in studio or when shooting
tethered on location.

What is the Auto Select capture function?

Auto select is by default ON but if set to off tethered capture will not
automatically change the primary capture for each capture, though
the thumbnails still will be continuously updated. This enables a
calmer workflow if an assistant is assigned to the computer whilst the
photographer can work uninterrupted.

How can | further edit my images after capture?

When your captures are created they are automatically stored in the
folder chosen in Location in the naming part of the Capture Tab. From
here you can do all editing just like if you had imported the file from a
CF-Card.
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Can | control my camera from Capture One?
Software control of camera for tethered sessions is the last tool in the
Capture Tool Tab.

Camera controls allows you to take control of the most relevant
functions of your Phase One camera; Program, Manual, Tv, Ay, X, e.g
besides programs you can take control of shutter speed and Aperture
when possible.

You can at any time control the Exposure value Adjustment.

All the above menus are created as drop-down menus, and you can
even control the steps of these; 1/3, %2 or 1/1 step compared to the
traditional scale.

Read all regarding supported cameras and backs in the release notes.

5.7 After tethered capture

Your first shot of a session can very wisely be used to set white balance,
use a greycard as a part of your image. When you have captured the
raw file, you can set white balance easily, by using the tool in the camera
section of the Capture tab, when this is satisfying, you can copy the
settings to the next capture, by using the Next Capture Adjustments.
This way you do not have to set white balance on all images afterwards.
Also if youre a Phase One digital back user, you can choose to upload
you White Balance directly to the back
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5.8 PRO Capture

Can | shoot tethered “into” an existing composition
provided by the art director?

The Crop Tool Tab provides the Overlay function, this allows
you to load in a sketch drawing e.g. from an Art Director.

The sketch drawing should be in RAW, TIFF, JPEG or PDF. On PC you
can use JPEG, TIFF, BMP, PNG, GIF. Browse your way to the file, and
choose show. You can now see a transparent version of the selected
image on your variant if you shoot tethered and want to check more
than one image at the time, just select the images you want to see with
the lay-out sketch drawing and it is on all at once.

You can control the opacity of the sketch drawing and also scale it up
or down as well as moving it by using the sliders, this will save you time
from cropping or scaling the images until you know you have the shot.

It is worth noticing that you can move the sketch drawing by using the
handtool, while pressing alt and mouse click.

Will the overlay be seen on my output file?

The overlay function is merely a possibility for you to check your capture
against a given layout. When you output the file, you output the RAW
that fits the sketch.

How can | make sure that my images matches for layer merging in
post process?

When making captures that needs to fit each other, the overlay function
will assist you in checking if the captures will match, this function can
easily be used in situations where you have the client in the studio, this
way you can easily illustrate the final result.

Use the same function when your client needs a photo matching an exact
layout, the overlay function will read the different format, by using overlay
function you can check or illustrate that your setup will match the task given.

Adapt the overlay file by using the sliders, to match your capture, or
simply use the “move overlay” hand tool in the cursor tools.
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5.9 Can | check focus and composition without looking in
the camera?

Live Preview is fully integrated with the Capture One software. When
the camera is attached and recognized, select Window>Live Preview
to display the composition window. The composition window can be
moved outside the Capture One application and ideally be placed on
another monitor adjacent to the set. The composition window is scalable
for long distance viewing and the color reproduction is the best in its
class. To further improve the workflow, it is possible to load an overlay
image (by using the settings from the overlay tool) and compose with
this as a guide line. To ease composition it is possible to turn on the
square grid by using the crop preferences.

Digital camera back support

Following digital backs support Live Preview out-of-the-box: P 20+, P
21+, P 25+, P 30+ and P 45+. The Live Preview functionality can be
purchased for the following digital backs as a hardware upgrade:

P 21, P 30 and P 45.

Camera body support. The following camera body support Live Preview
functionality:

— Hasselblad H series

- Hasselblad V series

- Mamiya 645AFD and 645AFD Il

- Mamiya RZ67 Pro Il and Pro IID

- Contax 645

- Technical cameras (4x5):
Arca Swiss, Cambo 4x5
Rollei Xact

Linhof M679/4x5

Toyo

Sinar

Plaubel and Horseman.

- Wide angle: Horseman SWD,
Cambo Wide DS and a range of adapters with 35 mm support.
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Launch

When the Live Preview enabled back is connected, the Window>Live
Preview menu item will be enabled. By default Live Preview is paused
in composition mode.

Shutter
Technical and wide angle cameras: Use the camera on full open or in
stopped down mode (with the shutter set on the preferred f-stop).

Medium format cameras: Open shutter and keep it in B or T mode
depending on choice of camera system. Hasselblad H: T-mode.
Hasselblad V: B-mode. Mamiya 645: B-mode. Mamiya RZ67 Pro Il
and Pro 1ID: T-mode. Contax 645: B-mode.

Press play
Start composition mode by pressing the play button.

Adjust the exposure

Notice the reading on the exposure meter. Since Live Preview works
without a physical shutter, it is important to adjust light/aperture for
optimum operating condition for the virtual shutter. Adjust until the
exposure meter is in the green area. For long shutter speed stay in the
lower half of the green area.

Adjust lightness

If the Live Preview image seems too dark or too bright, adjust the ISO
gain and/or the shutter speed. Lower ISO gain means less noise in the
image. Longer exposure time improves image quality at the expense
of a slower frame rate.

White balance

If the white balance is not correct, a new white balance can be
set using the white balance tool, and clicking on a gray area in the
composition preview. Typically, a gray chart is temporarily placed in
the setup for this purpose.

ONE

Set image scene

When the exposure is adjusted, the set can be composed. To
ease composition it is possible to turn on a square grid. The
amount of grid lines and their color are adjustable through the
use of the preferences.

To further improve the workflow, it is possible to load an
overlay image and compose with this as a guide line. Overlay opacity is
configurable in the overlay panel.

Launch focus window

With the composition and pilot lighting in place, the focus window
is launched by pressing the magnifier symbol, placing the magnifier
symbol in the area of focus interest, and then left click.

Handling the focus window

In the composition window the focus area is indicated with a box. The
focus window is launched and will be updated 1.5 to 3 times every
second, depending on the size of the window. The window can be
moved outside the Capture One application and ideally be placed on
another monitor adjacent to the set.

The focus window can be resized and provides zoom function for easier
viewing from long distance if needed Left-click with or without pressing
ALT for zooming in or out.

Pause Live Preview

The focus is adjusted while viewing the focus window. When the focus
has been adjusted and is considered to be perfect in all relevant areas,
the Live Preview is paused by pressing the pause button.

Capture

Close camera shutter. Close the Live Preview window. Start capturing.
The image is transferred to Capture One which immediately displays a
high quality preview. Focus can again be verified through the use of the
focus tool in Capture One.
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6.0 Optimizing the colors

Introduction
To create a properly exposed image, the correct amount of light needs
to reach the camera’s imaging sensor.

Once the sensor transfers the information into the RAW file, Capture
One allows the data to be edited by lightening or darkening the image.
Capture One allows fine tuning of the images. With the tools it is
possible to save an incorrectly exposed image. Bear in mind that these
tools are not a substitute for correct exposure and good photographic
technique.

If the image is too bright or over-exposed (the sensor has received too
much light), the highlights may be ‘blown out’. The sensor has received
so much extra light and cannot differentiate tonal differences in the
highlight areas.

Capture One has excellent new tools e.g. the ‘High Dynamic Range’
which recovers and expands detail in images with extreme contrast.

What is the best workflow for image optimization?
For most images, with correct exposure and white balance, few edits
will be required. Achieving a white balance from the given light source
can save you a great deal of work.
For images requiring optimization, the best workflow is as follows:

¢ Set the correct white balance and fine tune if necessary

e Color correct or enhance

¢ Adjust or fine tune exposure using exposure, brightness and/
or contrast sliders

For users comfortable with more advanced controls, first optimize levels
and then fine tune contrast with curves.
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Recommended exposure adjustment sequence

Y

‘ Exposure ’

Y

‘ High Dynamic Range tool ’

Y

‘ Levels & Curves ’

Y

ONE

The High Dynamic Range tool will help to recover loss of detail in
highlights and shadow areas. Be aware, the Highlight as well as the
Shadow slider will affect all colors and shades; first try carefully to
recover the information (pixels) hidden in the highlight, then easily
adjust the shadow tones.

What is the best sequence to combine exposure tools for image
adjustments?

The diagram to the right suggests a sequence for how to perform
exposure adjustments.

Prior to the exposure adjustments you should make initial white balance
adjustments.

Subsequent to the exposure adjustments you should make any crop
and sharpening adjustments you deem necessary

59



PHASEONE

6.1 White Balance

Why is there a wrong color balance in my images?

There are many variables that can cause incorrect color, but a good
starting point is to set the white balance correctly. — Always bring a
greycard on your shooting, if you want to make sure the images and
camera can be controlled properly.

When should | apply white balance adjustments to my image?

The best practice is to set the white balance of an image or group of
images before making other adjustments. When the White Balance is
set, you have the right colors, and then you can choose to add a color
tone to affect the look of the image.

What do the controls in the White Balance tool panel do?

Mode

Provides a list of different white balance presets e.g. daylight, tungsten,
fluorescent and such but also camera custom and shot, which is the
white balance used by the camera when the image was shot.

Advanced users may prefer to create their own or to choose alternative
options.

Kelvin

Changes the color temperature of the image within the range 800 to
14000 degrees Kelvin. By moving the slider to the right, the image will
become warmer (yellowish) and to the left cooler (blueish).

To fine tune the green/magenta balance, it is necessary to use the tint
slider.

Tint
Tint allows for fine tuning of the green and magenta balance.

The scale on the slider represents actual Kelvin value, subject to slight
variations from camera to camera.
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What parts of the image are best to use as a white balance source?
White balances should be created from a special white balance card,
if unavailable, you can try to find an area that is neutral grey, this takes
some practicing, as you have to remember the slightest color in the
area you set as White Point will affect all colors in your image. Try to
find a clean bright grey or neutral area, the darker the area is, the larger
is the chance that there can be noise making it very hard to do a precise
leveling of the colors.

How do | white balance my images with the pick white balance tool?
To do a ‘click balance’, select the white balance picker (w) in the tool
menu bar, Quick or Cursor Tool bar. The button will go orange to confirm
that it is active.

Select an area of the image that looks neutral (a grey or dark white area
if possible). The color picker takes this value as neutral grey and uses
that information to map all other colors.

Can | auto white balance my images?

Capture One has a built-in auto white balance. Select the image to be
neutralized and then click the auto white balance picker the image will
be automatically corrected by the software.

To apply auto white balance to a range of images, first select the images
to be adjusted, hold down the shift key and then click the auto white
balance button.

How do I get the ‘as shot in camera’ white balance?

Go to the Quick tool tab or the White Balance Tool Tab and select the
‘Mode’ pull-down menu. Choose the ‘shot’ setting and all selected
images will revert to the white balance they were captured with.
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How can | apply white balance from one image to others?
Select an image with the white balance and color balance settings you
like. Copy them with Adjustments>Copy Adjustments in the menu bar.
Select the images you want to modify and use the Apply settings button
on the menu bar to paste the settings to the image.

Note:

Images that are too dark
can be lightened by up to
2.5 stops (made 6 times
brighter). Bright images

can theoretically be made
darker by the same amount.
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How can | define a certain skin tone on my models?
Often it can be troublesome to achieve colors of skin, or an exact
color of clothing, especially when photographing in different light
conditions.

Skintone is working like the well-known White Balance, but ap-
plies to any color defined in advance.

Mark up “Pick to create new” and select a picture showing the correct
colors, pick the color using the Skin Tone picker, automatic you will see the
save-as dialogue, then choose a relevant name for your new skin tone.

Skin Tones can be used to define all colors, e.g. the blue in a shirt can be
defined by a dedicated studioshot before going out-door for the model shot,
and when a Skin Tone is defined and saved you will be able to use the tone
in any session.

What are the differences between defining skin tone and setting

white balance?

White Balance is created to neutralize the color picked, to a perfect grey
balance; this is why the grey-card is needed to exactly point out the grey
tone.

The Skin Tone tool is created to adjust a selected color to an already de-
fined color. by adjusting the white balance of the capture.
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6.2 Color Balance
The Color Balance tool allows the opportunity to create a unique look.

How can I fine tune the color balance in my image?

Fine tuning of color to the highest standards is possible in Capture One,
but the accuracy of the results is dependent on having a well calibrated
monitor to accurately reflect the changes made to images.

First, an accurate white balance should be set. Then color adjustments
can be made to create the desired mood for the image. Like other
settings in Capture One, these changes can be saved as a preset and
applied to additional images.

The advantage to setting the white balance first is because saved
color adjustment presets are relative to the colorvalues, created in
whitebalance or at import. A group of images can be white balanced to
a neutral value and then a preset can be applied. An example would be
to use a preset to warm up the colors in a selected group of images.

What do the different controls in the color balance panel do?

The Color wheel

Changes the color balance of the image by moving the neutral point
around the color wheel, you can drag it using the mouse but fine tuning
should be done with the H and S sliders.

‘H’ Hue
Moves the color-tone point around the color wheel to provide subtle
color changes.

‘S’ Saturation

Increases the saturation by moving in or out along the radius of the
color wheel.
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Note:

Wide angle and zoom lenses
have the largest tendencies
to create chromatic
aberration as does high
contrast photography,
especially if overexposed.

If | create a color balance that | like, how can | save it?

This point is discussed further in the points relating to white balance.
Color adjustment can be saved and named by selecting the preset button
and selecting ‘Add preset’. Give it a meaningful name and select ‘OK’.

Color presets are relative to the image they are applied to, not absolute.
This means that all values added are added to the values created in
White Balance or at import.
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How can | edit defined colors only?
The Color Editor allows you to select a narrow color area, and adjust this
area without affecting other colors in the capture.

The Color Editor tool is split in basic and advanced, Basic is created for
standard editing, whereas Advanced are providing a much more specialized
tool for editing defined shades of color in saturation, brightness, hue and
smoothness.

Why work in slices?

Working in larger areas of color will avoid the image to appear unnatural.
The slice will allow your adjustments to all shades of the selected color
slice.

Select the color area which you want to adjust using the basic color correc-
tion picker, now only one “pie-slice” is highlighted. The black circle indicates
you're the picked color value, and the thin black lines indicates the end of
the smoothness effect; Smoothness indicates to you how far the mixture
will be applied, this ensures a natural look to the selective changed colors,
but images like the feathers, showing many colors in the relation with each
other, you will have to keep smoothness on a lower level.

It is also possible to “just” select one color slice from the menu below the
sliders. Or choose global if you want to affect all colors at once, this is how-
ever a more creative tool that shouldn’t be used instead of colorbalance.

To help you determining the areas that actually changes, you can check-
mark “View selected color range” this will remove color from all not select-
ed colors.

Can | block entire color areas completely?

The Color editor can be used not only to change colors, but also to satu-
rate or de-saturate specific colors or groups of colors. Saturation is created
to adjust up to 80% in both directions, so repeat de-saturation 2-3 times
and you will have black/white areas whilst preserving other colors than the
selected.

Original color Target color

Mark-up the “view selected color changes” will automatically desaturate all
not-selected colors.

You can make up to 30 selective color changes in one image.
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How narrow a color space can | work in?

Depending on your smoothing settings your area can be quite
narrow; this is very useful when adjusting colors, as you often do
not want to change the entire look on the image.

Area affected of the color change is partly controlled by smooth-
ing, which determines how floating the transition from the select-
ed area of the pie, to the neighboring area. Check this by check-marking
the “View Selective Color Changes”

If you wish a tighter defined area of color, you should use the advanced tab
of Selective color tool, this will make you work in smaller spaces instead

of pies, but if the changes are not made carefully they will not necessarily
look natural.

How can | see which areas of my image are affected by the color
changes?

Check-mark in “View Selective Color range” this will desaturated all not af-
fected areas of the image.

When working in Advanced Selective colors, you control the working area
much more precisely; first pick the color you wish to adjust, this area can
be enlarged or made smaller by adjusting the dots, smoothing is affecting
all directions from the selected area, but will not affect cross the center of
the color wheel.

When “View Selective Color range” is selected it will work “live” constantly
refreshing the view, try and change smoothness and you will instantly see
the change of black&white area.

On the example you can notice the difficulty in working on selecting colors;
firstly select the color you wish to edit, check for unwanted effects and if
you are catching all shades of the selected color.

Not only is the color we selected here placed or the border between blue
and purple, while the background shows some green-ish shades due to
smoothness. After adjustments of color area and smoothness you have
the color of the blue feather isolated, leaving all other colors remain out of
influence.

On the final image we have a significant brighter and more saturated blue,
the change of color is obvious on this example, but when working in small
areas or moving between closely related shades, you may want to rely on
the before/after color to check the actual difference.
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How can | reuse a selective color set-up?

By saving the new color scheme either as a Selective Color Preset or as a
ICC profile, the ICC profile will allow you to make the adjustments as you
capture the photo tethered, saving you working hours in the editing.

A saved ICC will automatically appear in the ICC drop-down menu found in
the menuitem “Other”

How can | adjust a narrow colorspace

Using Advanced tab of the Color Editor will allow you to work independently
of the color pies. A much smaller area will be selected as your adjustment
area of color shades.

The work area can be adjusted in all directions by pulling the white dots
and by adjusting smoothness. Use the “View Selected Colors” to check your
selection.

Now you can adjust the selected shades, in lightness, saturation and hue
I the example we have saturated the yellow beds after saturating the blue
feather in the basic editor.

If you want to change the colors more than the sliders will allow - repeat
the action, by re-selecting the color you wish to adjust.

When do | save as ICC profile and when do | save as preset?

ICC profiles can of course be used later on in your work, like presets. But
ICC profiles created in Capture One can be transferred to 3rd party applica-
tions, to keep the color space exactly like you need it.

The example shows more saturated blue feathers and yellow pearls, being
saved as ICC profile, to keep the colors of future session the in the same
color work area.
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7.0 Optimizing exposure
7.1 Basic controls

My image is too dark/bright. How do | adjust?
The best way to lighten or darken an image is to use the exposure slider.

For more precise and advanced control, the exposure slider should
be used to centre the data within the histogram and define an initial
exposure, ensuring that no highlight or shadow clipping occurs.

When this stage has been completed, use the levels controls to fine
tune the lightness and darkness of the mid-tones of the image.

How do | use the image adjustment sliders?
Sliders provide the best way to adjust exposure and contrast. Use one
tool at a time before moving onto the next tool.

Exposure
Adjusts the exposure in much the same way as the controls on the
camera do. The slider is calibrated to provide a range of +/- 2.5 stops.
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Contrast
Moving the slider to the right increases contrast throughout the image.
Moving to the left decreases.

Brightness

Provides a tool to primarily brighten the mid-tones of the image; this
tool has the effect of increasing mid-tone contrast. By contrast the
gamma or centre slider of the levels tool works on the mid-tones, but
has the effect of lightening shadow areas and reducing contrast.

Saturation

Increases or decreases saturation of the image. When saturation is
decreased the image is Black and White. Then the histogram changes
from RGB to monochrome though the image is still in a RGB color space
chosen as out output color space. The saturation slider is not “just”
saturation, it is intelligent saturation. The negative values represents
regular saturation settings, the positive values are comparable to what
3rd party software would call “vibrance” — Vibrance is more gentle to
the skintones, and will be able to enhance for instance blue sky without
oversaturating the rest of the image.
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7.2 Managing exposure — Levels

For advanced exposure adjustment, it is recommended that levels are
adjusted first, followed by curves. The curves tool has been designed
not to clip image information and will only operate on tones within the
defined white and black points of the image.

What are correct settings for Levels?

In an ideal situation, levels should be adjusted to slightly clip the end
points of the image histogram at the shadow end and to the maximum
highlight level on the right side of the histogram.

The images below show before and after adjusting the levels for
an image.

You can see that the black point and white point adjustments have
been brought in very slightly. This has the effect of lightening the lighter
tones and darkening the shadow tones in the image, at the same time
increasing contrast slightly. The process has to be done very carefully
in order to preserve the feeling that the image evokes.

The highlight warning function (view>enable exposure warnings, can
be configured to provide visual feedback when adjusting the Levels.

Once the highlight and shadow points of the image have been fixed,

the density or mid-tone values of the image can be adjusted using the
centre or gamma slider on the levels tool.
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When do | use Highlight and Shadow picker?

The white point and black point pickers are best used in the context
of ‘controlled’ studio images where, in conjunction with a quality color
chart, they can be used to precisely set the black and white points of
an image.

Custom Target Levels

Custom Target Levels extend the abilities of the levels tool, enabling the
means to control the output values and to reduce contrast in the image.
This is particularly useful where an image has data in the highlight area
that is in danger of clipping. The theory is that you set the target level to
the desired value and then use the picker tool to choose the area within
the image that you wish to match that brightness level.

With conventional pixel based image tools, output levels are used
to compress the tonal range of the image to fit in a smaller space, for
example re-mapping highlight values of 255 to 245. Whilst this prevents
clipping, it means that there is a sharp cut-off of image data, leading to an
hard transition between data and no data when the image is re opened.

Capture One 4 Target Levels work in such a way that the tones are
remapped, yet avoiding hard transitions in highlight areas and resulting
in pleasant, more natural looking images.

How do | use custom target levels?
Set a desired value for an area in the highlight area of the image where
it is important to retain detail; for instance 240.

Select the white point picker tool from the Levels Tool Tab and then
‘pick’ the highlight area within the image.

The same process can be repeated for shadow values and the black
point picker.

ADVANCED USE ONLY:

Preferences allow these values to be set for every image in Pick Target
Levels. Do not do this unless you really understand the implications.
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7.3 Managing exposure - using curves

How do | work with curves?

Levels are used to control the overall tonal distribution of an image.
Curves provide the ability to remap the area within the shadow and
highlight limits set by the Levels tool areas to produce a desired image.

There are certain ‘classic’ curves that are used in image applications to
achieve specific results in images. Best known is the “S” curve which is
used to increase contrast in an image.

The S curve achieves the increase in contrast by pulling down the
shadow values, normally on the quarter tones and increasing the values
of the tones at the three-quarter tone mark as shown in the image.

The brightness values at the quarter tones, before applying the curve,
are around 65 (with image tonal values from black 0 to white at 255).
The curve darkens these tones to around 50, whilst the three-quarter
tones at 190 are raised to 200, lightening them in the final image.

The inverse S curve has the opposite effect of lightening the shadows
and darkening the highlight tones, causing a reduction in contrast.

For advanced use, the Pick Curve point picker tool (p) can be used to
pick a specific tonal area within an image. This value is added to the
curve to allow adjustment of the values for that part of the image.

The image below clearly shows how the value picked on the image
translates to the image curve.
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7.4 Managing exposure - using High Dynamic Range tool

The bulk of image adjustments can be done with the exposure slider
and the levels/curves tools.

There are two scenarios where the High Dynamic Range tool may prove
to be essential.

In certain situations, image contrast is such that clipping may occur
at both ends of the histogram. In such cases the HDR tool provides a
means of optimizing the image to deal with the extreme contrast and
prevent the clipping of highlights and shadows.

High Dynamic range also provides the means to make use of images
that have been accidentally over or underexposed to an extent that
render them unusable with conventional exposure tools.

How can | optimize the dynamic range of an image?

The dynamic range of an image is optimized at the shooting stage by
adjusting exposure to capture the maximum amount of data. This may
result in an image that does not look optimal on the LCD display.

Bear in mind that around 1/2 - 1 stop of additional data can be recovered
from overexposed highlights.

Once the image has been opened in Capture One, it is optimized by
using the various tools within the software to adjust the data. The High
Dynamic Range tools can help with ‘difficult’ images, where contrast
is extreme. Applying a soft-proof profile for the output should be
configured in order to edit for this output device.
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How can | lighten shadow areas in an image & how can | darken
highlight areas in an image?

A good way to adjust the shadows and highlights in your image is with
the curves tool.

Use the Pick Curve Point tool (u) to click in the area of the image to be
adjusted. A point will be put on the curve and this allows very precise
adjustment of the exact tonal area of the image that you prefer. To fine
tune this, use the arrow keys on the keyboard. This practice is much
more accurate as compared to relying on the sliders in levels to achieve
an overall result.

How can | prevent highlight and shadow detail loss?

Correct exposure in combination with the dynamic range tool, where
necessary, prevents highlight and shadow detail loss.
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How do styles work on my image?

Styles is a combination of presets added at once to provide

your photo a certain look, this will save loads of working hours in post
process. The changes will be seen as soon as you mouse-over the
style, but will only be applied as you click on the style.

my model

Styles do not add or change your image in any way you couldn’t have
done on the various sliders. But by adding the style, you only have to
polish the photo afterwards.

- 36 # blue-power

If you apply more than one style it is important to keep in mind, that
the latest applied style will override the previous applied style, if the
values exceed the previous style. -If the values do not exceed the
values of the former applied style, the former style will still be partly
visible on the photo.

The values of the style are not placed “on top” of the previous values
— the highest value replaces the lower value. Remove a style by
entering the style drop-down-menu, the top area of this will show
a list of added styles and the possibility of removing these as you
mouse-over these menu items the photo will be live updated to show
the changes.

Exposure [Brightness | Contrast Saturation
Adjustments | 10 -10 7
Result 10 -10 7

\Z

Exposure | Brightness | Contrast Saturation
Exposure |Brightness | Contrast Saturation Style 2 6 10
Style 1 8 -5 9 Style 1 8 -5 9
Adjustments | 10 -10 4 9 Adjustments | 10 -10 7
Result 8 -5 9 7 Result 8 -5 6 10
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Can | create and save my own style?

When you have created a look to your photo that you want to keep,
copy the adjustments, and decide which changes to keep in the style,
it is recommendable to not e.g. include White balance in a style.

When you have check-marked the adjustments you prefer to keep in
your new style, press on the Styles button and choose “Save As Style”
the Save Style window will allow you to save the style where you want,
but the Styles folder will let Capture One find the style, all styles work
across sessions and platforms.

Name your style a recognizable name and you will find the style in the
Styles Drop-down menu, below the default styles.

How can | transfer and share styles?

Styles saved, will be stored in the Styles folder, commonly placed on
the Mac path Library>Application Support>Capture One>Styles; the
Style file will be a “.costyle”, this file can be copied to other computers,
and works cross-platform.

Save S Ve I [3
Where: | i'_J.Sl.VIes m

( Cancel ) (Save )

How can | modify a style?

When you have applied a style, and still want to change to attain the
effect you want, polish the image until perfect — and copy the settings,
save the style, save using a new name, to not over-write already made

[ Capture One style.

[ Application Support

@8 Library How can | see if a style is applied to an image?

& hla £92H The applied style will do no “hidden action” on your raw-file, it is merely
8 Users a set of adjustments, hence you can see the changes, and modify these
A Mac HD on the regular tools such as saturation.

HE HLAMacBookPro o )
Easier is checking the Styles drop-down menu, above the Default styles

e ' you will find the applied styles on the primary variant. The styles is listed
D4 _Drew_4

- with the last one applied on top of the rest, the bracket indicates if the
g D4_Drew_4 previously applied style is Adjusted or partially or fully overridden.
Skin Tones
[ Skin Tones
[ Styles e

ONE 78



8.0 Image settings

How do | copy settings from one image to a group of images?
Choose an image and make all the necessary adjustments to it. When
finished click the Copy button and check the Adjustments Clipboard
Tool Tab. Choose “Select Adjusted” There will be a list of settings that
have been applied to the image.

Next to each setting, there is an orange check or tick. If you wish to
apply all changes to other images, leave all the boxes checked. If you
prefer to apply only a subset of the changes, deselect the options not
required.

Go to the browser and select the group of images that you want to
apply changes to. Click on the Apply button and paste the settings
into the selected image. To apply settings to multiple images, hold
down the shift key.

How can | ensure the same look between images?

First of all your of course have to have the approximately same
exposure values, then make changes to one and then use Copy
Adjustments and Apply Adjustments to paste the settings to the other
RAW files as described above. If you are Capture One 4 PRO user,
you can also use styles.

Preset is a clever way of creating shortcuts in the daily work, instead

of repeating your corrections again and again, save the preset, and
get a precise and easy adjustment.

ONE

If the images have different white balance or exposure — Will a settings
copy be absolute or relative?

Any settings copied from other images are absolute. For instance if your
white balance is currently tungsten, 3500K and you paste a daylight
balance from another image, the setting will be an absolute one; it will
not be halfway between tungsten and daylight.

Can | save the settings with the RAW files?
Capture One saves all settings in a subfolder called “Capture One” in
the same folder as the RAWSs.

All changes made to a RAW file are saved in a .COS settings file. This
file is located in the Capture One folder with the RAW files. This file
contains all the information regarding edits made to the RAW file.

The Cache folder is also found here. Within this folder is a Proxies
folder. In the Proxies folder there are .COP files. These are the previews
viewed in Capture One.

Settings files from previous versions cannot be read by Capture One 4.
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9.0 Variants

Introduction

A variant is actually a copy of the settings used to create an image
preview; it is not a duplicate of the original file. This means that it is
possible to create multiple image variants without using any significant
disk space.

Variants provide an easy way to try different settings or modify the
work you have done on an image without risk. Original RAW data is
untouched by any changes made.

How can | create different expressions from one image?

Variants provide an easy way to try different settings or modify the work
you have done on an image without risk and without copying large
RAW files.

New Variant creates a duplicate of the image using default settings.
The image is created as it came out of the camera or DNG file except

rotation.

Clone Variant creates an exact duplicate of the image you are working
on; complete with any changes you have made.
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How do | delete Variants?

The easiest way to delete a Variant is marking the variant in the Viewer
or browser and press Delete or on PC press Backspace. You can also
right-click and choose Delete from the menu.

When a Variant is deleted, only the settings file for the Variant is deleted.
The original image file is untouched.

What settings does a Variant inherit from the original image?
Normal Variants inherit the raw default settings from the original image
+ metadata and Lens Cast corrections (where appropriate with Digital
Back files).

Clone Variants inherit all settings from the original image, including
white balance, color, exposure and other changes that have been made
in Capture One.

With the exception of Lens Cast correction (Digital Backs only) and
Metadata, any changes made to an original image can also be applied
to avariant. Lens Cast is a special case, as it is regarded as a correction
of the original image. That correction is applied to the original and
automatically applied to any variant.

When creating a variant, metadata information is not changed because
the content and the creator of the image have not changed.
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9.5 Lens Correction Tool

The Lens correction tool is a brand new way of working on classic
optical issues, like distortion, light fall off and purple fringing.

As light travels through any lens it will be bend, there are several ways
of trying to avoid the bending lines or loss of sharpness; Apo chromatic
lens elements, highly sophisticated coating and advanced lens groups
can “only” lower the effects of the bended light.

Phase One R&D have created special profiles for a series of lenses from
studying the light, this evolved into the Lens correction tool.

D A

AF 35mm f/3.5
35mm
None

Default

¥ Chromatic Aberration (Default) How can | correct bended lines?
¥ Purple Fringing It is not unusual experiencing bending
il Cswortion - dl lines especially when photographing
PG @l architecture, there are large differences in
2 ':;'":;L" the capabilities of lenses, but it is natural to

e D\ — 5 i . experience bending lines.
LUy 0 W W If your lens is already known by Capture One 4 PRO, corrections will
Wi BE| 6 50 |EE |§E (&% automatically be added as the image is loaded, you decide however, if
#E WE gH| |8#| (HE] |3 i you want to edit the corrections or you can remove them completely by
- — = . removing the check-mark.
NEIE @ (TR E‘ (| !

LLIFALIFLL LR L L If Capture One already knows your lens, it should not be necessary to
gEEE BB EE ;. B L - do further corrections, still it is possible to edit the applications preset

manually by using the sliders.
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Why are the sliders not active?

Sharpness and light fall off will only work if
Capture one already knows the lens used,
Bl this is due to the fact that these tools are [IEECEUES
N Ml created upon optical knowledge about
specific lenses.

Chromatic Aberration (Default)

Purple Fringing If the light fall off is not active try the vignetting tool in
Distortion _ ol very small doses or the high dynamic range tool.

Vignetting 0.00EV

Can | correct the image if my lens is not yet known by Capture One?
If your lens is not recognized by Capture One, you can create your own
correction based on distortion and Chromatic Aberration analysis and
purple fringing. For each focal length you work with you can choose
to save these changes as a style, and thereby create your own lens
correction, you should however be aware that a change in aperture
values can make a difference in how the light is travelling through the
lens.

¥ Chromatic Aberration (Default)
W Purple Fringing

¥ Distortion

Vignetting 0.00EV
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What is Chromatic aberration, and can | avoid it?

Photographers will from time to time experience different light and lens
related flaws, like chromatic aberration, Capture One includes features
to reduce such undesired effects.

Chromatic aberration occurs because light is divided in many
wavelengths. The light waves will react slightly differently when passing
through the lens, therefore the light will have slightly different exact
focus points, as the light is enlarged slightly different by the parts of
the lens. The light will often pass perfectly through the midst of the
lens, but the further to the edge of the lens, the larger difference of the
enlargement when the light waves enters the chip or film.

As chromatic aberration is different from lens to lens, the lens correction
is not “just” removing color appearing to mismatch, the chromatic
aberration feature is created to act according to the combination of our
knowledge on the single lens and an analysis of the image thereby the
software will surgically remove the chromatic aberration where possible
without affecting the surrounding pixels.

The Chromatic Aberration ‘filter’ currently supports Mamiya
and Phase One lenses in combination with the Phase One camera (or the
Mamiya AFD) and a Phase One digital back.

If you want to minimize the chromatic aberration zoom to 400% on your
image to check the effect, and press Auto-button and shortly after the
chromatic aberration is minimized.

Purple Fringing is an effect which looks similar to the chromatic
aberration and is also caused by the different exact focuspoints in the
red wavelengths compared to the rest; this feature automatically, checks
for the effect in high contrast areas, like when using the Chromatic
Aberration feature.
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Feature

How can | avoid color errors when photographing shining or high

i mpon: - contrast motives?
Brass, Chrome and many metallic products can provide purple fringing,
o this happens as the wavelengths of the light have slightly different focus

None

points; Purple Fringing is related to Chromatic aberration and both are
seen when you have high contrast motives.

1_ Purple Fringing

Purple fringing is very clear on this image, you should go in 100% to
check the result, and simply check-mark purple fringing and this will
get rid of the issue.

¥ Light Falloff

Vignetting

Chromatic aberration will often be seen on both sides of the white
pixels on black background as purple/pink and green on the other side,
to avoid Chromatic Aberration, check-mark in the box, and Capture
One will automatically find the pixels showing chromatic aberration and
neutralize the colors of these.
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9.6 Lens Cast Correction

What is Lens Cast?

Lens cast is a commonly known lens issue, creating darker areas
towards the edge of the lens, this occurs as the light are entering the
individual glass in your lens, the more glass and groups the higher risk
of visible lens cast.

What is Lens Cast Calibration?

Capture One 4 is equipped with one of the most powerful core engines
in the market, by an analysis of the Lens Cast shot Capture One will
determine the need of correction, keeping the correction smooth and
natural.

What Lens types are supported?

A large variety of lenses needing correction is already supported; these
analyses have been made by Phase One R&D and covers different Carl
Zeiss and Hasselblad lenses. More lenses will come in time, but it is
very easy conducting your own analysis. see the list in lens correct - all
lenses supported are found in presets of Lens Correction tool tab

How do | create my own Lens Cast Correction?

Lens Cast is a well-known issue especially on large format and on
wide-angle lenses. Capture One is providing and easy 2-step lens cast
correction tool placed in the Lens Tool Tab.

First do a lens cast correction shot, using a OPAL PLADE, import the
image to Capture One 4 and choose analyze in the LCC drop-down
menu.

You will automatically be asked to name your new LCC profile, used a
recognizable name, reference to the lens, focal length and aperture, as
you will need LCC filters for all Apertures and focal lengths if possible.

When the analysis is done the LCC profile will be saved and you will
find your personal LCC profiles in the LCC drop-down menu.
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Use cursor arrows to move or edit crop area

PHASEONE

10.0 Compose your image

Introduction

Image Composition in Capture One is the area where images can
be straightened or rotated and then cropped precisely to fit layouts
and prints.

Cropping of an image can be done freehand or with the constraints
of specific ratios such as popular photographic paper sizes. A grid
is provided to facilitate alignment and there is the option to display
labels, with dimensions related to the selected output destination.
Controls for this are available in the preferences (Preferences > Crop
> Show labels).

In combination with the output tool, images can be cropped to specific
sizes for output.

The rotation function is geared towards straightening of images where
object or horizons are not as vertical or horizontal as was intended.
As the rotation is applied, the image is automatically cropped to the
maximum usable dimensions.
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10.1 Crop tool

How do | crop an image?
To crop an image, select the crop button in the Composition tool panel
or the cursor tool selector.

To quickly free crop an image, make sure that ‘Unconstrained’ is
selected and simply drag a crop frame in the image area. Depending
on the preferences that have been set, there will be a semi-transparent
mask hiding the area that is being cropped. The dimensions will indicate
the size of the cropped image.

To view the cropped image, select another cursor tool and the image
will be shown in its final form. You can still see the original image with
the cropping mask in the thumbnails. Re-selecting the crop tool at any
time will allow adjustment of the crop settings.

The best practice is to drag the edges of the preview inwards (the cursor
will turn into a two-way arrow) until the desired crop has been achieved.
To reposition the cropped area, click in the middle and the button will
turn into a cross. Move the cropped area. When the desired result has
been achieved, select any other button from the cursor tool selector.
The crop will be applied and the updated preview will fill the viewer.

How can | reuse a crop setting from an image to other images?
Once an image has been cropped the settings can be copied and
pasted to multiple images in the same way that other settings can be.
Adjustments > Copy Adjustments and then select other image and
Adjustments > Apply Adjustments. Hold down the shift key to paste to
multiple images.

How can | set a crop aspect ratio?

Select one of the predetermined Aspect Ratios from the drop-down
menu. Your crop will automatically be constrained to these aspect
proportions. When you make a crop in an image the crop orientation
(landscape vs. portrait) will automatically switch to maximize the crop
area staying within the aspect ration constraints.
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How do | switch crop sizes on and off?
The crop size can be switched off by going to

Crop > Ratio > Unconstrained
Alternatively, it can be turned on by selecting a crop ratio.

How can | change the crop masking?
The crop masking can be changed in preferences. Preferences > Crop

Here it is possible to change both the opacity and the brightness of the
mask being used.

How do I revert to the uncropped image?
If you click Adjustments>Reset or Reset adjustments button the
cropmask disappears.

10.2 Crop Settings

To create new crop settings:

Select Ratio > Add Aspect ratio. Name the crop in a meaningful
way and then type in the ratio. For example new ratio — ‘10x8’, Ratio 10
x 8. Another might be called ‘Square’. By setting the ratioto 1 x 1, every
image would be cropped to a square shape.

Can | save a crop aspect ration and reuse it?

Select Ratio > Add Aspect ratio. Name the crop in a meaningful
way and then type in the ratio. For example new ratio — ‘10x8’, Ratio
10 X 8. Another might be called ‘Square’. By setting the ratio to 1 x 1,
every image would be cropped to a square shape.
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10.3 Crop to output

How does Crop > Ratio > Output work?
This gives a similar result to using a crop ratio with a fixed destination
as above.

Go to the output tool and select an output size, let’s say 5x4”

Select the crop ratio as output and everything that you crop will now fit
within 5 x 4”. One of the neat features about this setting is that the crop
automatically swaps between horizontal and vertical as you drag in the
image. This allows the option to crop to a horizontal or vertical shape
according to what works the best.

How does the crop settings work with outputting to fixed dimensions?
The most precise way to crop an image to an exact size is to set process
recipe to, the output desired, i.e. 10x10. Create an aspect ratio that is
the same dimensions of the desired print size. For example, an 8 x 10
print is desired. | will create an aspect ratio that is 8 x10. Consequently
when | apply a crop, the crop will fit an 8x10 sheet of paper regardless
or image orientation.
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10.4 Straightening

How can | straighten images?

Nothing is more irritating than an image where the horizon is just a
few degrees away from horizontal or a vertical building that is crooked.
Capture One was the first RAW workflow software to allow rotation.
Capture One 4 now offers an even more sophisticated straightening
tool.

How do | straighten an image?

Select the Rotation/Straighten button in the cursor tool palette or in the
composition tool and drag along a straight edge that should be vertical
or horizontal. Fine tune the straightening or rotating by mouse scroll over
the slider, this way you will change the degree of rotation by 0.1 at the
time if carefully scrolled.

If I need to straighten an image, when should | crop?

It is easier to rotate the image first, as the software automatically crops
the rotated image to the maximum usable dimensions. Following this,
the crop can be fine tuned by the user, perhaps to fit to a specific
aspect ratio such as 6x4 inches/10x15cm.

Can | apply straighten or crop settings to a group of images?
Straighten the image as required, optimize the crop and then copy the
settings using the Copy/Apply buttons on the menu bar.

Select the next image/group of images that you want to apply the same
settings to and click the Apply button. Remember to hold down the
shift key to apply to a group of images. Identical crop and rotations will
be applied to all images.

To enhance the functionality of the copy and paste settings, it is possible

to select which of the settings are pasted — see the Settings chapter for
a full explanation of this feature.
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Rotate Freehand

To adjust the image by eye, move the slider on the angle tool to left or
right. A grid appears, making it easy to align vertical or horizontal lines. If
you wish to freehand rotate more images at once, firstly freehand rotate
one image, then use Copy/Apply Adjustments.

Capture One allows adjustments up of to 45 degrees. For adjustments
greater than this, use:

Rotate Left/Right

Allows rotation of 90 degree to the left or right. By pressing shift while
rotating Left/Right you will rotate all selected RAWSs. Fine tune the
rotation or rotating by mouse scroll over the slider, this way you will
change the degree of rotation by 0.1 at the time if carefully scrolled.
Rotate more than one image at the time, by first selecting the images,
hold down shift while pressing Rotate icon.

How do I revert to the uncropped image?

Undoing any change in Capture One is performed by using Edit>Undo or
of course the Undo button. In the rotation tool, it is possible to select the
reset button or you can use Preset drop-down menu > Rotate snap 90°.
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10.5 Sharpening

Sharpening is an essential process when working with images created by
digital cameras. The Capture One 4 sharpening is a newly designed and
enhanced unsharp mask. The purpose is to compensate for the effect of
internal filters in all DSLRs that soften the image and to compensate for the
softening effect that occurs when the images are printed.

By default, Capture One 4 sharpening settings have been configured
to provide a good looking image on screen. Additionally, the software
comes with a number of presets that are accessed from the pull-down
menu. Any of these presets can be activated and set as a default for
all images.

When animage is destined for post-production or retouching in other software,
it is recommend processing the image without sharpening applied.

How do | sharpen an image?
Capture One has arange of presets, formulated to provide good starting
points for sharpening images for most purposes.

If the concept of sharpening is unfamiliar to you, take a little time to
look at how the settings change the appearance of images on screen
at 100%, and compare these to final prints.

Typically, an image that is sharpened, for print or press, will look overly
sharp on screen but produce a pleasing result when printed.

What settings are needed for Inkjet printing?
Inkjet printers vary, from small desktop models, to ultra-wide, large
format machines.

Start with the supplied inkjet setting, check the result and if desired,

adjust. If you modify the settings, then the new settings may be named
uniquely and saved as a preset.
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What settings are needed for printing in a magazine or brochure?
If your images are processed for later printing it varies how much
Sharpening is needed, a good starting point would be:

Amount: 350
Radius: 0.9
Threshold: 2

Fine tune this to suit your needs and the recommendation from the
printing place and save as preset.

How can | see the effects of the sharpening?
The effects of sharpening and noise reduction are shown as they will
appear in the final image, in the viewer.

Zoom to 100% either by using the Zoom tool - or if you are using the
hand cursor just double-click where you want to check details.

When you at 100% it is easy to see the changes as you work with the
detail tools.

How can | determine what’s the right amount of sharpening?

A rule of thumb for sharpening used to be that the image should look
over-sharp on screen to look correct in print. These ideas have been
superseded.

The current thinking is that a 2 stage workflow is better. First sharpen
the fine detail in the image.

Use the capture or raw pre-sharpening setting.

Secondly, a more aggressive sharpening affect can be used. This should be
applied when the image has been sized according to printing dimensions.

There is no accurate measure of ‘what is the right amount’. Sharpening
is a skill that is learned over time.

If you feel insecure on the right amounts of sharpening, try out one

of the many Sharpening presets, after selecting the preset, you can
always edit the parameters further

Can | turn off image sharpening?
Turn sharpening off by selecting ‘Disable Sharpening’.

There is no sharpening applied behind the scenes. 94
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10.6 Noise Reduction

Luminance noise exists in every digital image. This noise is caused by
the light sensitive chip, regardless of ISO. Normally this noise is more
visible at high ISO values.

Higher Noise levels at high ISO values are caused because the signal
has been amplified.

Luminance

Removes the pattern-like noise often present in shadow areas. Best
practice is to set Luminance to 25, even for low ISO images. Ideally it
should be left on a low setting, such as 25, even for low ISO images.
Images with noise that is displeasing increase the setting value and
check the effect in the Viewer at 100% magnification.

Color

Removes color noise from images, typically noticeable as subtle green/
magenta patterns. It is very difficult to recommend specific settings as
noise varies from camera to camera, but the program defaults provide
a good starting point. The viewer provides a clear view of the effect of
filters on image noise.

How can | remove noise from images?

Noise should be removed from the images using a combination of the
above tools. Capture One automatically applies some noise reduction
to images, based on the ISO and exposure data from the camera that is
contained in the image metadata. The default settings provide a good
starting point for further adjustments.

What kind of noise can | remove in Capture One?
Capture One allows the removal of luminance and color noise from
images using the color and luminance noise reduction sliders.
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How can | raise contrast in hazy or low contrast images?

Contrast is one of the variables to be used when adjusting hazy images,
but the new PRO tool Clarity has proven to be an extremely effective
tool.

Clarity is adjusting contrast and slightly also sharpness on basis of pixel
frequency. This is done in relation to an analysis of the image made by
Capture One 4PRO.
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ISO 100 1/200 sec /9 80 mm

CFO00574.TIF

How can | avoid Moiré?
In very simple terms Moiré can occur, when you are capturing a motive
fine pattern details, which the sensor lack resolution to reproduce.

with

Moiré can be an issue when photographing clothes and with
architecture photography.

Often the simplest way to avoid Moiré is to moving back/forward a bit while
photographing and/or changing aperture.

Sta

t by providing a small portion of amount, just until you see an effect,

them ad pattern until you see a change and then finish with more amount.

You

need to handle this with caution as too much of the Moiré tool can

interact with lines and colors you do not want affected.

ISO 100 1/200 sec f/9 80 mm CFO00574.TIF
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11.0 Metadata

Introduction
Metadata is a term that means data about data. In photographic terms
it refers to data that describes your image and how it was taken.

Metadata in Capture One can be broken down into two types:

Basic

Basic is a subset of IPTC, data that is regularly used by photographers
to add captions. This area provides the ability for the user to add
Copyright and Caption information to the image. In the browser it
is also possible to rate the image and this will be shown in the
metadata window.

EXIF

EXIF information is data that is embedded into the file by the camera
and is not editable by the user. Capture One shows two types of
EXIF data.

EXIF Exposure data includes shutter speed, ISO, aperture and all other
user configurable settings.

Importantly, it includes white balance information according to the
camera at the point of capture. This directly affects how the thumbnail
and preview are displayed in Capture One EXIF Camera data provides
comprehensive details of the hardware used, detailing the body (or
digital back), lens and serial number.
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What Meta data can | enter/change?

You can change the Basic metadata, filename, rating caption and
copyright. You can set Caption & Copyright information when you
import the images, this can later come handy, when producing Web
Contact Sheets.

After import of the image you can change the metadata on the Metadata
tab doubleclick on the line, to activate Caption and/or Copyright. If
you choose to rate your images this rating will also be a part of your
metadata, this will help the future users of the image when they need
to sort.

How can | search for images with specific metadata/Exiff data?
Within the Browser Toolbar, there is the option to show image thumbnails
or to view images as a list.

First, choose to view thumbnails as a list. This is the best way to sort
images. From the View pull-down menu choose sort. The sort pull-
down menu offers various metadata and Exif data to choose from.
Sorting method is ascending. If descending values is desired simply
click no the header title and the order is reversed.

99



Format ~ TIFF
Compress LW
Adobe RGR (1998)
300 pxfin
Fixed
100
Disable
Open With -~ Adobe Photoshop €53
File lcon @ Create thumbnails on save
OUTPUT NAMING
Format * Capture Name
name

Sample 20060919_158

Location fUsers/nwhb._..rary/Output

Example of output recipe for compressed TIFF
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12.0 Get the right output

Introduction

Images can be processed from Capture One as TIFF or JPEG files, with
options for file compression, bit depth and color space, in addition to
the normal options for resolution and size.

There is also the option to create contact sheets for web use.

For archival use, Capture One can export images to the open standard
Digital Negative, .DNG files.

Images intended for manipulation or post production in other software
should be exported as 16-bit TIFF files in the Adobe RGB or ProPhoto
RGB color spaces.

16-bit output increases the color graduations from black to white in
each of the three color channels from 256 in 8 bit output, to 65,536
per channel in 16-bit. This makes a huge difference in the way that an

image can be adjusted without visible damage. It also prevents banding
on gradients, such as skies.

12.1 How can | create a process recipe?

Process Settings consist of a selection of options to create and output
images as required. The Process Settings Tool tab provides many
choices for the output of your images.

Here is a summary of what each setting does:

Format

Choose the output file format, depending on the determined use of the
file.

TIFF for maximum quality or JPEG for size and convenience.

TIFF files provide the option of 16 bit output.
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Format = JPEG
Quality
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Resolution 72 pxfin
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OUTPUT NAMING
Format ~Capture and Job Name
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Sample 20060919_157_web

Location fUsers/nwb...rary/Output
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Example of output recipe for web

ONE

Compression
Both TIFF and JPEG files may be compressed.

TIFF is lossless format, as are both forms of TIFF compression; LZW
and ZIP. This is the best choice for pixel based image archiving.

JPEG is acompressed file, the higher the compression, the smaller thefile.
However, the higher the compression, the greater the loss of information
from the file. JPEG compression also adds noise to an image.

The following settings are recommended for JPEG Quality Image
Options. Choose 90 or above for glossy magazines. Choose 80 or
above for any other printed form.

Colorspace
Choice of Color space depends on the final purpose of the file.

For web use, the only choice is sSRGB, for other uses check with your
client or lab. Adobe RGB is often recommended.

Resolution

Resolution is typically 300 px/in, but again, for web this will be 72 px/in
and many processing labs will have different requirements.
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OUTPUT NAMING
Format = Capture and Job Mame

name _print

Sample 20060919_158 print

Location fUsers/nwb...rary/QOutput

Example of output recipe for print
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Size
The default setting for scale is Fixed, 100%. This setting can be changed
as required.

The options “To Width” and “To Height” are self-explanatory. “To size”
option is not so.

The best way to understand the “To size” option is by example. For
instance you have a group of images to be processed for the web. The
area that the image must fit is 500 x 500 pixels.

The best way to accomplish this request is to choose “To size” and
set the dimensions 500 x 500 pixels. Navigate through the images and
crop them as desired.

When these files are processed the dimensions will be 500 x 500 pixels
and will satisfy the specific processing request.

The “To size” option is available when the crop tool is set to output. For
example the output size is set to 10 x 8”. Navigate through the images
and crop to output. The images will have a 10 x 8” crop applied.

This technique can also be applied when cropping with the crop tool
set to fixed ratio.

All of these examples will give accurate output and quicken the rate at
which you work.

Output Scaling
New to capture One 4 is the ability to scale images on output from
10-250%.

Previously only available in the Pro version of the software, this means
that upsizing images is as simple as selecting the output size required.
Because the scaling is carried out on the RAW data, the scaling is of the
highest quality and suitable for any type of use.
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Open with

Allows Capture One to automatically opening the processed file in an
application. Most users choose Adobe Photoshop™ to open the file
immediately after processing.

The best practice when processing a batch of files is to set “Open
with...” to None. This will prevent computer related resources from
being depleted.

Naming

Output naming provides a range of options for naming the processed
files. Adding a job name in the blank field increases these options
and the helpful sample panel provides a preview of how the chosen
convention will work.

Process destination

Beneath naming, is the heading ‘Location’. This is where you choose the
output destination for processed files. Click on the button and navigate
to a suitable folder. This can be on a local or networked drive. This can
also be set on the output location on the Library Tool tab.

Process Summary
The Process Summary window provides an overview of all the settings
chosen for an image before processing.

This includes the actual and final processed size, name, format and
file size.

Clicking Presets provides a choice to process the primary or variant
image.

When you press the Process button, the file or files will start processing
the Primary Capture automatically. If you press SHIFT whilst activating
the processing, you will start processing all selected instead of just the
Primary.

Output to DNG
Many see a benefit of using DNG for archival purposes.

Outputting to DNG format in Capture One 4 in essence creates a new
RAW file. There are no options for size or compression with this format.
All changes made to the image will be discarded when creating the
DNG file.
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Disable

None
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OUTPUT NAMING
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PhaseOne
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Often you will need the same image in different variations, an editable
and printable 300Dpl, a web version 72Dpl created to match with etc.
This can be done very easily as your process recipe is automatically
saved in the recipe profiles on top of the tab.

When you are done creating your output recipe you can name it and
then press “+” to add the next recipe. Each new recipe is based on the
previous settings. This way you can create more than 1000 of different
process recipes, which should be sufficient for most photographers.

It is important to notice, you do not have to save changes in the process
recipe, the changes you make, are automatically added to the process
recipe that is high-lighted.

Through time you will find it practical to create many different recipes,
a clever system could be naming after client name, or purpose... you
can choose to only view the selected recipes, this makes it easier to
verify that the right recipes are selected. The images created in the
batch appears as one image referring to the rawfile, but if you, as this
example have chosen to create several images from one rawfile, the
images will simply be placed in the chosen output folder

Q
Name Date ifi Size Kind
M Fashion008 1.jpg Today, 2:58 PM 9.2 MB JPEG image
B Fashion008.dng Today, 2:58 PM 32.7 MB Digital Negative file
M Fashion008.jpg Today, 2:58 PM 560 KB JPEG image
Bl Fashion0OB.tif Today, 2:58 PM 51.4 MB TIFF image
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Can | output to different folders?

By using advanced tab in the process recipe you can decide
how the files of the individual recipe should be stored. The folder
will be created automatically when process button is pressed.

Shew Erabiled Only

You can even decide to have the individual process recipes
stores in their own specific subfolders, using the advanced tab on the
process recipe.

o

This way you avoid having to sort and split up files from the job before

# Create thumbeails on s

5 G o Loy 8 capture . B Custom Name 003,11 shipping them to your client, or to the different post process places.
Drew in t..blin forest  » Capture One.col [ website -

Cl:mn One.colés k

(5 MoveTo -

R - Can | convert to other than RGB profiles?

You can convert to various different RGB and CMYK workspaces by
deciding in the process recipe, it is of course always recommendable
to convert and check the colors thoroughly before processing.

Embed camera profile

Generic RGE Profile

. You can also change to CMYK in View>Proof Profile, in this menu you
PhaseOne RCB(Trinitron CL18 DSO)

SR Cotor Space rfie ' will find the same colorspaces as in the process recipe. This way you

Adobe RCE (1998)

privsivatiis can do your adjustments in the CMYK image keeping an eye on the

AppieRCE 1
N final result _—~. CMYK Values

CIERGE

Color LCD-4271880
ColorMatchRCE

Ceneric RGB Profile
NTSC1953

PAL_SECAM

Phase One - Mac Monitor

PhaseOne RCB(Trinitron GL8 DSO)
ProPhoto

SMPTE-C

SRCE Profile

SRCB Color Space Profile
‘WideCamutRCE

EuropelSOCaatedFOGRAZT
EuroscaleCoated
EurcscaleUncoated
Ceneric CMYK Profile
Hasselblad 250CCR 40090

Hasselblad 280CCR 30K390
Hasselblad 330GCR 20695
Hasselblad 3305kel 30K75
Hasselblad 3S0GCR 20695
Hasselblad 3505kel 30K90
JapanColor2001Coated
JapanColor2001Uncoated
JapanColor200ZNewspaper
JapanStandard
JapanWebCoated

Offset print - DIC Catalog
Offset print - Euro Catalog
Offset print - Toka Catalog
Offset print - Toyo Catalog
Offset print - US Catalog
PhotoshopdDefaultCMYK
PhotoshopSDefaultCMYK
USSheetfedCoated
USSheetfedUncoated
USWebCoatedSWOP
USWebUneoated

Show Recommended
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12.2 Create Web-Contact sheet

To output a group of images to a web based contact sheet, select the
images and choose File > Make Web Contact Sheet.

A dialogue presents itself offering the opportunity to provide information
such as title, description, etc.

The best practice is to choose the dark grey background color. Light
grey background color option is also available, if preferred.

An amazing feature of the web contact sheet is that the size of the
images and thumbnails can be customized. If you have access to a
secure server or a password-protected web folder, it makes sense to
preview images to clients at 800 pixels so they can see the quality of
the images. You can see the pixel size of thumbnails or preview size
when adjusting the slider, the number indicates how many pixels the
images are wide.

Once all options have been selected, choosing Export outputs a
complete folder to add to your web site.

It is important that the name is in lower case and without spaces — you
can use hyphens or underscores.
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Can | add/disable sharpening for my contact sheets?
No, sharpening can be applied to the images themselves, not to the
web contact sheet as a whole.

What is the best workflow to adjust exposure for images for web?

The most effective way to adjust images quickly for output is to fine
tune exposure and contrast, then copy the settings and then to select
all similar images and paste the settings to them.

‘®00 Jenny

(<]>] = file:// [Users /MP/Desktop/ Contact 20Sheet /indexhtml 2(Q- Goo

(1] Apple Google Maps Wikipedia
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12.3 How does the batch work?

After the output recipe is created mark the files to be processed. Now
choose File>Process, or press Process button. The batch of files will be
processed to the selected output folder.

If you wish to Process all selected instead of just one, first select the
images you wish to process then hold Shift whilst pressing Process or
hold Shift whilst choosing File>Process, this menu item will be Process
Selected when pressing Shift.

Capture One has been designed to process batches of images quickly
and efficiently.

The Batch of files will start processing immediately after choosing
File>Process or Process button.

Batch processing can work in two ways depending on your preference:

By default, processing happens in the background without noticeable
effect on the performance of the application.

There is the option to stop the batch queue, only enabling it to process
images when other work has finished or overnight.

To set the application to work in this way, go to the Batch Tool tab.
At the bottom of the tab, press the ‘Stop’ button. Processing will not
commence until this has been reset to ‘Start’.

When there are a large number of images in the batch queue, processing
priority can be changed by dragging and dropping unprocessed files
around in the queue.

You can always remove files from the batch queue by marking the file
or files and pressing backspace(mac).

History

The batch tool tab shows a history of all recent files that have been
processed. If for any reason, there is a need for further copies of these
images, the relevant ones can be selected and the ‘Reprocess’ button
selected.
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Capture One 4 - Keyboard Shortcuts

Function

AutoAdjust (Primary file)
AutoAdjust (ALL) Selected

Trash (Primary file)
Trash (ALL) Selected

MoveTo (Primary file)
MoveTo (ALL) Selected

Process (Primary file)
Process (ALL) Selected

Reset (Primary file)
Reset (ALL) Selected

RotateLeft (Primary file)
RotateLeft (ALL) Selected
RotateRight (Primary file)
RotateRight (ALL) Selected
Rotate Snap (Primary file)
Rotate Snap (ALL) Selected

Viewer Zoom In
Viewer Zoom Out
Viewer Zoom to Fit
Viewer Zoom to 100%

New Variant
Clone Variant

Copy Adjustments
Apply Adjustments

Import
Capture

Exposure Warning Toggle

ONE

Mac

CMD+F
Shift+CMD+F

Backspace

Windows

Ctrl+F
Ctrl+Shift+F

Delete

Option+CMD+Backspace Ctrl+Shift+Delete

CMD+J
Shift+CMD+J

CMD+D
Shift+CMD+D

CMD+R
CMD+Shift+R

CMD+Option+L
CMD+Option+Shift+L
CMD+Option+R
CMD+Option+Shift+R
CMD+Option+X
CMD+Option+Shift+X

CMD+0
Option+CMD+0

CMD+Shift+C

CMD+Shift+V

CMD+K

CMD+E

Ctrl+dJ
Ctrl+Shift+J

Ctrl+D
Ctrl+Shift+D

Ctrl+R
Ctrl+Shift+R

Ctrl+Alt+L
Ctrl+Shift+Alt+L
Ctrl+Alt+R
Ctrl+Shift+Alt+R
Ctrl+Alt+.

Ctrl+Plus
Ctrl+Minus
Ctrl+0
Ctrl+Alt+0

F7
F8

Ctrl+Shift+C
Ctrl+Shift+V

Shift+Ctrl+l
Ctrl+K

Ctrl+E

Function

Tool tab shortcuts

Tooltabs

Library Tab
Capture Tab
Quick Tab

Color Tab
Exposure Tab
Composition Tab
Detail Tab
Metadata Tab
Adjustments Tab

Previous Tab
Next Tab

Mac

Key

CMD+Option+1
CMD+Option+2
CMD+Option+3
CMD+Option+4
CMD+Option+5
CMD+Option+6
CMD+Option+7

CMD+Option+<
CMD+Option+->

Windows

Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrl+6
Ctrl+7
Ctrl+8
Ctrl+9

Ctrl+Shift+Tab
Ctrl+Tab
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Capture One 4 - Keyboard Shortcuts

Function

Select All
Deselect All
Invert Selection

Select Previous
Select Next

Set Compare Item
Clear Compare Item

Next Tool Tab
Previous Tool Tab

Browser Toggle Visible
Browser Toggle Position
Browser Toggle Auto

Tools Toggle Visible
Tools Toggle Position
Tools Toggle Auto

Undo
Redo

Mac

CMD+A
Shift+CMD+A
Ctrl+l

CMD+Left
CMD+Right

Return
CMD+Return

Ctrl+Tab
Ctrl+Shift+Tab

CMD+B
Shift+CMD+B
Option+CMD+B

CMD+T
Shift+CMD+T
Option+CMD+T

CMD+Z
Shift+CMD+Z
(Ctrl+Shift+2)

Navigationwindow when zooming Space

Help
Show preferences

Hide Capture One
Hide Others

Quit

ONE

CMD+?
CMD+, (comma)

CMD+H
Option+CMD+H

CMD+Q

Windows
Ctrl+A
Ctrl+Shift+A
Ctrl+Left
Ctrl+Right

Return
Shift+Return

Ctrl+B

Ctrl+Shift+B

Ctrl+T
Ctrl+Shift+T

Ctrl+Z
Ctrl+Y

F1
Ctrl+K

Alt+F4

Function

Remove rating (Primary file)
Remove rating from (ALL) Selected

Rate 1 star (Primary file)
Rate (ALL) Selected 1 star

Rate 2 stars (Primary file)
Rate (ALL) Selected 2 stars

Rate 3 stars (Primary file)
Rate (ALL) Selected 3 stars

Rate 4 stars (Primary file)
Rate (ALL) Selected 4 stars

Rate 5 stars (Primary file)
Rate (ALL) Selected 5 stars

Cursor Tools Shortcuts
Cursortool

Use Shift to toggle
Select

MoveTo

Trash

Pan

Zoomln

ZoomOut

Crop

Rotate
FreehandRotate
LeftRotate
RightRotate
WhiteBalance
HighlightPicker
ShadowPicker
CurvePointPicker
CopyAdjustments
ApplyAdjustments

Mac

0
Option+0

y
Option+1

2
Option+2

3
Option+3

4
Option+4

5
Option+5

Key

>PP>CICSTITITITONNILSLSI

Windows

0
Shift+0

1
Shift+1

2
Shift+2

3
Shift+3

4
Shift+4

5
Shift+5
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Capture One 4 — Mouse Shortcuts

If your mouse or pointing device has a scroll (wheel) function you can
use it in selected areas to control features of Capture One.

The Viewer

Place your mouse cursor over an image in the Viewer; moving the
scroll wheel up will zoom into an image and moving the scroll wheel
down zooms out. You don’t have to have images to selected to zoom
in or out.

The Browser

If you place your mouse cursor anywhere in the Browser you can
scroll up and down in your image collection by using the mouse scroll
wheel

Sliders and input fields

Place your mouse cursor over a slider in any given tool and you can
use your scroll wheel to fine-tune the slider settings, by scrolling
up or down on the mouse. You don’t have to select a slider, simply
place your mouse cursor over it and start scrolling. You can easily
move for slider to slider and control to control and make fine-tuned
adjustments.

Similarly you can place your mouse cursor over any input field in a
control and adjust it up or down by using the mouse scroll wheel.

Curve points
The mouse scroll wheel is a great tool for fine-tuning your curves
work. Pick curve points and use the mouse scroll wheel to carefully
adjust these.
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